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Copyright

The 2019 Drake Tax Manual Supplement: Partnerships, Drake Tax Software, and any other 
related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, 
including all ownership rights. This document, associated software, and related material are the 
property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the 
material in this document in an unaltered form only for your personal, non-commercial use or for 
non-commercial use within your organization. Copyright, trademark, and other proprietary 
notices may not be removed.

© 2019 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no war-
ranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for dam-
ages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake 
Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered 
trademarks of their respective companies.
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Partnerships (1065)

THE BASICS OF DATA ENTRY FOR A PARTNERSHIP 
(1065) RETURN ARE THE SAME AS FOR THE 1040. 
NAVIGATE THROUGH DATA ENTRY, FIELD- AND 
SCREEN-LEVEL HELP, AND KEYBOARD SHORTCUTS 
JUST AS YOU DO IN THE 1040 PROGRAM. SEE THE 
2019 DRAKE TAX USER’S MANUAL FOR THE 
BASICS OF USING THE PROGRAM. (THE MANUAL IS 
AVAILABLE ON THE INSTALLATION CD AND ON THE 
DRAKE SUPPORT WEBSITE: 
SUPPORT.DRAKESOFTWARE.COM > TRAINING 
TOOLS > MANUALS.)

What’s New in Drake Tax for Partnership Returns

Drake Tax programs its tax software according to the latest IRS rules and regulations. 
The 2019 program reflects all changes to credits and deductions, including discontinu-
ations. For details on new regulations for 2019, see the IRS instructions for Form 
1065.

The following changes have been made to the 1065 package in Drake Tax for the 2019 
tax year:

• The program now uses “tax basis” by default as the capital account method, 
reflected in section “L Partner’s Capital Account Analysis,” of Schedule K-1. Pre-
parers can us the “Item L on Schedule K-1 (Partner's capital account analysis)” 
section of the PRNT screen, to change the capital account method. The check 
boxes for “Tax basis,” “GAAP,” “Section 704(b)book,” and “Other,” have been 
deleted from item “L.”

IMPORTANT
Be sure to review the 2019 Drake Tax User’s Manual – 
available from the Support.DrakeSoftware.com web-
site – for details on the changes to the tax program and 
practice management tools.
Tax Year 2019 9



What’s New in Drake Tax for Partnership Returns Drake Tax Manual Supplement: 1065
• The MISC screen, added to the Miscellaneous tab of the Data Entry Menu of 
the business packages, includes fields to help preparers keep up with the produc-
tion schedule of a return: Date promised, Date picked up, how much the client 
was charged last year (the 2018 prep fees field), and a check box for indicating 
clients who did not pay their bill last year. This is preparer information only and 
has no affect on the return.

• The Disaster Designation field on the MISC screen is for entering the name of a 
federally designated disaster for those business entities that incurred disaster 
losses and that are subject to federal disaster rules. An entry in this field is printed 
across the top of the return but does not otherwise affect the return The field is 
limited to 75 characters (including spaces).

• An option to Update Misc Codes on Screen 1, available during the update pro-
cess (Last Year Data > Update Client 2018 to 2019) was added to the federal 
business packages. For more information on using these code fields, see “Miscel-
laneous Codes” in Chapter 5 of 2019 Drake Tax User’s Manual.

Forms and Worksheets for “Pass-Through” Packages

Here are some of the changes that affect the Partnership package for the 2019 tax sea-
son.

Form 8997 Form 8997, Initial and Annual Statement of Qualified Opportunity Fund (QOF) 
Investments, along with the corresponding data entry screens, has been added to the 
1065 package in Drake Tax. An investor in a qualified opportunity fund (QOF) uses 
Form 8997 to inform the IRS of the QOF investments and deferred gains held at the 
beginning and end of the current tax year.

For more, see “Form 8997, Initial and Annual Statement of QOF Investments” on 
page 67.

Form 8996 A partnership uses Form 8996, Qualified Opportunity Fund, to certify that it is orga-
nized to invest in Qualified Opportunity Zone (QOZ) property.

For more, see “QOF Investments” on page 68.

New QBI 
Statements

Drake Tax includes new worksheets with 1065 returns that include Qualified Business 
Income:

• The “Statement A – QBI Pass-through Entity Reporting” worksheet that includes 
Section 199A items, will be attached to and filed with Schedules K-1 this year. 
The “Qualified Business Income Information” worksheet – a summary of State-
ment A – will also be generated with the return. (This second worksheet will not 
be filed and is intended for the entity’s records.)

• “Statement B – QBI Pass-through Entity Aggregation Elections,” will be attached 
to and filed with Schedule K-1, and a “Qualified Business Income Aggregation” 
worksheet – a summary of Statement B – will be generated for entity’s records.

• “Statement C – QBI Pass-through Entity Reporting,” will be attached to and filed 
with Schedule K-1, for patrons of specified agricultural and horticultural coopera-
tives.
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See IRS instructions for more on these statements.

Schedule 
K-1

Following are changes made to Schedule K-1 and to Drake Tax’s 1065 package.

A new section was added to item “H” of Schedule K-1. There is now a line for the TIN 
and the name of the disregarded entity in the event the disregarded entity owned an 
interest in the partnership. This information is entered on the K1 screen.

• Item “N” for “Partner's Share of Net Unrecognized 704(c) Gain or (Loss),” begin-
ning and ending amounts, were added to Part II of Schedule K-1.

• Part III, line 4, has been divided in three lines:

– 4a, “Guaranteed payments for services”

– 4b, “Guaranteed payments for capital”

– 4c, “Total guaranteed payments”

In Drake Tax, guaranteed payments to partners is entered on screen DED, with adjust-
ment fields on screens K, RENT, and 8825.

• Part III, line 20, codes for Qualified Business Income (QBI) items have been 
changed to a single code “Z,” which refers to the attached QBI statement.

• Lines 21 and 22 were recently added to Part III by the IRS, but for 2019, these 
questions do not have to be answered and the check boxes are not active in the 
1065 package.

Schedule B Following are some changes to Schedule B:

• Line 25, “Designation of Partnership Representative,” on page 3 of Form 1065, no 
longer requires a U.S. taxpayer identification number.

• Line 27 is for the number of foreign partners subject to section 864(c)(8) 

• Line 28 is for any transfers between the partnership and its partners subject to the 
disclosure requirements of Regulations section 1.707-8

In Drake Tax, data for these lines is entered on screen B (“Schedule B. cont” tab), 
which is available from the General tab of the Data Entry Menu.

NOTE

Notice 2019-66, released December 9, 2019, provides that partner-
ships are not required to report partner capital accounts in item “L” on 
the tax basis but must be calculated as provided in the 2018 Schedule 
K-1 instructions. Tax basis reporting will be effective for partnership tax-
able years that begin on or after January 1, 2020.

The reporting method of the capital account will now be printed in item 
“L” of the K-1. If you are not using the tax basis reporting method, open 
screen PRNT in Drake Tax (available from the Miscellaneous tab of 
the Data Entry Menu, and from the Item L section, choose the method 
you are using.

NOTE
The amount of line 4b, “Guaranteed payments for capital,” flows to the 
partners’ Schedule K-1 and is reported on the partner’ individual 1040 
return, on Schedule E, line 28, column “K.”
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See “Additional Information” on page 27 for details on completing Schedule B.

Completing a 1065 Return in Drake Tax

The basics of data entry for a partnership (1065) return are the same as for the 1040. 
See the 2019 Drake Tax User’s Manual for the basics of using the program, or log in 
to DrakeETC.com to view online tutorials and webinars designed to teach new users 
all aspects of data entry in Drake Tax.

Updating a Prior-Year Return in Drake Tax

If you prepared a tax return in Drake Tax last year, you can update the return for the 
current year in either of three ways:

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2018 to 2019 (recommended) 

• When you open the return for the first time in the 2019 program and are prompted 
to update it

• With all other returns in the program using Last Year Data > Update Clients 
2018 to 2019 (not recommended)

When you update a 1065 return that was marked as “final” the previous year, the pro-
gram informs you that the return was marked final before prompting you to proceed.

For more details on updating prior-year returns, see “Updating Client Files” in Chap-
ter 4 of the 2019 Drake Tax User’s Manual.

Header Information

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1065.

Name and Address

Use screen 1 to complete the partnership name and address section of Form 1065. For 
state purposes only, if the partnership has an alternate address (such as a P.O. box), 
you can enter it in the Address Line 2 field at the bottom of screen 2. 

Screen Code: 2 Access screen 2 from the States Info link on screen 1 or, from the States tab of the 
Data Entry Menu, or by entering 2 in the selector field and pressing ENTER.

“Doing
Business 

As” 

Whatever is typed into the DBA field of screen 1 will be printed below the legal name 
of the partnership in the “Name” section of the main form (and on certain other forms, 
such as Schedule K-1).

Use of the DBA field is optional and data entered there is not required by the IRS. It is 
provided in the program for the return preparer's convenience.

The DBA can also serve as a “continuation” line for entity names that are too long to 
fit into the legal name field. Be aware, however, that not all federal forms accept data 
12 Tax Year 2019



Drake Tax Manual Supplement: 1065 Header Information
from a continuation (or DBA) line. For those forms, only the data entered in the legal 
name field is used.

Tax Year

The program uses the calendar year as the default period for all partnership returns. 
No date entries are required on screen 1 for a December 31 tax year-end.

Fiscal and 
Calendar 

Years

If the partnership uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If not a calendar 
year section of screen 1.

52-53-Week 
Tax Year

For information on electing a 52-53-week tax year, see “Electing a 52-53–Week Year 
(Initial Return)” on page 76.

Short-Year 
Returns

A partnership may have a short-year return if changing accounting periods with IRS 
approval (Form 3115) or if this is its first or last year in business and the tax year is not 
a full year.

Screen Code: 
YEAR

Short-year return election information and 52-53-week tax year information is entered 
on the Year screen, available on the Miscellaneous tab of the Data Entry Menu or 
from a Year link on screen 1.

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year beginning and Fiscal year 
ending fields, even if the firm uses the calendar year for full-year returns. (These 
dates will appear on the top of the federal form.)

2. Click the Year link (figure 
at right) to open the Year 
screen. On the Year screen, 
make your short-year selec-
tion from the Other short-
year reason drop list. Type an explanation in the Explanation text box. (Your 
explanation will be displayed at the top of the first page of the tax return.)

3. If you selected “General Explanation” from the Other short-year reason drop 
list, type details on the reasons for filing a short-year return in the Explanation 
text box.

NOTE Not all states recognize the use of a DBA name. Those state packages 
ignore data entered in the DBA field.

NOTE The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.
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For information on making elections through the ELEC screen, see “Elections” on 
page 69.

Boxes A through J

Enter most information for boxes A through J (top of Form 1065) on screen 1. Note 
that boxes D (Employer identification number), F (Total assets), I (Number of Sched-
ules K-1), and J (Schedule C and M-3 attached) are completed automatically based on 
information entered elsewhere in the program. Other boxes are:

• Box A — Principal business activity

• Box B — Principal product or service

• Box C — Business code number (Press CTRL+SHIFT+S to search activity codes)

• Box E — Date business started

• Item G — Initial, final, name change, address change, or amended return

• Item H — Accounting method (Select Cash, Accrual, or Other on screen 1; if 
Other, enter a description of the method used.)

• New for 2019: Item K was added to screen 1 and to page 1 of Form 1065:

– Aggregated activities for section 465 at-risk purposes (Mark this box if any 
activities covered by the at-risk rules can be treated as a single activity. For 
more information, click in the box and press F1 or see Pub. 925.)

– Grouped activities for section 469 passive activity purposes (Mark this box if 
any activities covered by the grouping passive activities can be treated as a 
single activity.) For more information, click in the box and press F1 or see the 
IRS instructions.

In Drake Tax, the item “K” check boxes are available on screen 1.

Income and Deductions

Enter income and deductions on the INC (Income) and DED (Deductions) screens. 
INC screen amounts flow to Form 1065, page 1, lines 1a to 7. (Also see “Other 
Income (Loss)” on page 16.) DED screen amounts flow to Form 1065, page 1, lines 9 
through 20.

NOTES

• For more extensive details on entering short-year return information 
into Drake Tax, click inside the Explanation text pane of the YEAR 
screen and press F1 to see the help.

• The program may not correctly calculate depreciation, gains, or 
losses for a short-year return. Depreciation for a short-year return 
can be manually entered on screen 4562 or screens 6, 7, 8, and 9.

• For more information on short-year returns, see IRS Pub 4163.
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“Other income” and “Other deductions” data is shown on attached statement work-
sheets in View/Print mode of the return.

Gross Receipts

Enter gross receipts or sales and returns and allowances on the INC screen.

Cost of Goods Sold (Form 1125-A)

For cost of goods sold entries, complete screen A (Form 1125-A, Cost of Goods Sold). 
Click the 1125-A link on screen INC, or select A from the Data Entry Menu.

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3, “Inventories.” Note that the “Inventories” lines on screen L (Schedule L 
- Balance Sheet - Assets) are override fields; entries there override inventory data 
from screen A.

Line 5, Other 
Costs

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
ous lines. In Drake Tax, two fields on screen A are provided for line 5: one for other 
costs including depreciation and one for other costs excluding depreciation. (See fig-
ure below.)

In the Other costs - depre-
ciation field, enter any 
depreciation that relates to 
the cost of goods sold 
(unless the amount is flow-
ing from the 4562 Detail 
screen with COGS selected 
from the For drop list). 

Note that this field on screen A is an override field; an entry here overrides the calcu-
lations from the 4562 screen and automatically adjusts the total depreciation that 
flows to page 1 of Form 1065. Make an entry in the Other costs - excluding depreci-
ation field to open a detail worksheet (CTRL+W). Enter a description and an amount 

NOTE
Screen DED has one field for any deductible entertainment expenses 
and one for nondeductible entertainment expenses. Meals are still 50% 
deductible. 

NOTE
The IRS does not require a detail worksheet (CTRL+W) for gross 
receipts; therefore, if you are using the trial balance import feature, do 
not include a detail worksheet for this line—or for any other line that 
does not require a detail worksheet.

NOTE
On screen A, items 9a through 9f are direct-entry fields and follow the 
format of IRS Form 1125-A. For more information on completing 
these fields, click in any field and press F1 or consult the IRS instruc-
tions.
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for the items. The depreciation amount is included on the statement for other costs and 
should not be included in the Other Costs detail worksheet.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 80), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in data entry of Drake Tax. When the trial balance is imported, 
the COGS depreciation expense amount flows directly to the appropriate line of Form 
1125-A and is calculated accordingly. For more on depreciation and trial balance 
import, see “Depreciation” on page 88.

Ordinary Income (Loss)

Ordinary income or loss from other partnerships, estates, and trusts (line 4 of Form 
1065) flows from either screen K1P (Schedule K-1 from another partnership) or 
screen K1F (Schedule K-1 from a fiduciary).

Net Farm Profit (Loss)

Screen Code: F The partnership’s net farm profit or loss (line 5 of Form 1065) flows from information 
entered on screen F (Farm Income and Expense). Farm profit or loss from other 
partnerships, estates, or trusts appears on line 4 of the return. To enter this information 
from the INC screen, click the links on line 4 to screen K1P or screen K1F. Enter the 
farm profit or loss from other partnerships, estates, or trusts on line 1 of screen K1P or 
line 6 of screen K1F. The K1P and K1F links are also on the Other Forms tab of the 
Data Entry Menu.

For information on farming partnerships with a corporation partner, see Pub. 225, 
Farmer’s Tax Guide.

Net Gain (Loss)

The amount on line 6 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 
1065 flows from Form 4797. Amounts can also flow from screen 4562, but only if that 
screen shows assets sold and property type.)

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. 
Specific INC screen entries are displayed on attached statements in View/Print mode 
of the return.

Amounts from the following screens also flow to line 7:

• Screen 6478 — Form 6478, Biofuel Producer Credit

• Screen 8864 — Form 8864, Biodiesel Fuels and Low Sulfur Diesel Fuel Produc-
tion Credits

NOTE Line 16b on the DED screen is an adjustment field for depreciation 
from Form 4562 not entered on screen A.
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Additional fields on the INC screen include:

• Interest income on receivables

• Recoveries of bad debts deducted in earlier years

• Section 481 adjustments

• State tax refund (cash basis)

• Taxable income from insurance proceeds

Enter additional sources of income not listed above in the Other income (itemize) 
field. Begin typing in that field and a detail worksheet (CTRL+W) is opened with 
fields for descriptions and amounts.

Enter other income (loss) from a partnership, estate, or trust on the K1P or K1F 
screen. (Click the links on line 4 of the INC screen.)

Compensation and Wages

Use line 9 of the DED screen to enter wages and salaries paid. Do not include guaran-
teed payments to partners or salaries or wages reported elsewhere in the return, such 
as the amounts included in COGS, elective contributions to a section 401(k) cash or 
deferred arrangement, or amounts contributed under a salary reduction SEP agree-
ment. (Drake Tax automatically adjusts salary and wages for employment credits.)

Guaranteed Payments and Partner Health Insurance

Use the DED and K screens to report guaranteed payments to partners and partner 
health insurance. Note that guaranteed payments and health insurance are entered as 
separate amounts.

Guaranteed 
Payments

To report guaranteed payments to partners:

• Enter total guaranteed payments on the DED screen, line 10.

• An entry on line 4a and 4b of screen K (Income/Loss tab) adjusts the amounts 
(adds to or subtracts from) entered on the DED screen.

• To allocate the total guaranteed payments among the partners, click the SA link to 
the right of the amount field on lines 4a and 4b of screen K (Income/Loss) tab. 
(For details on using the SA screen, see “Special Allocations” on page 35.)

Guaranteed payments should include any payments (or credits) to a partner for ser-
vices rendered. Include the use of any capital the partner provided if the payments (or 
credits) for that capital are not determined by the partnership’s income and can be 
allocated to a trade or business activity. These entries should not include any payments 
and credits that should be capitalized or any distributive shares of partnership profits.

NOTE Guaranteed payments to partners can also be reported on screens 
8825 and RENT.
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Partner 
Health 

Insurance

To report partner health insurance:

• In the “Partner’s health insurance” field on the DED screen, line 10, enter 
amounts paid during the tax year for health insurance by a partnership on behalf of 
a partner for services as a partner (including a partner’s spouse or dependents or 
children under age 27 who are not dependents). (See field help on line 10 of the 
DED screen for more information.)

• An entry on line 13d, item “M, Amount paid for medical insurance,” of the 
Deductions tab of screen K overrides the amount entered on the DED screen and 
the 8825 screen for the partners’ health insurance premiums.

• To allocate the total amount of health insurance costs among the partners, click the 
SA link to the right of the amount field on line “M” of the Deductions tab of 
screen K. (For details on using the SA screen, see “Special Allocations” on 
page 35.)

Entries flow to boxes 4 and 13 of the partners’ Schedule K-1, to the total on line 13d 
of Schedule K, and to Form 1065, page 1, “Guaranteed payments to partners.”

For information on the partnership’s contribution to a partner’s Health Savings 
Account (HSA), see Notice 2005-8, 2005-4 I.R.B. 368.

Repairs and Maintenance

Use the DED screen to enter the costs of repairs and maintenance. See Form 1065 
instructions for IRS requirements regarding costs that can be entered here.

Bad Debts

Use the DED screen to enter the total of all bad debts that became worthless during 
the 2019 tax year, but only if these debts related to a trade or business activity. Deduct-
ible non-business bad debts should be entered as short-term capital losses on screen 
8949.

Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the partnership rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the partnership, and then 
complete Part V of the 4562 (screens 8 and 9).

Taxes and Licenses

Use the DED screen to enter tax and license payment data. Amounts entered here flow 
to the “Taxes and licenses” line of Form 1065, and to the “Wks Tax/Lic” worksheet in 
View/Print mode.

NOTE Cash-method partnerships cannot take a bad debt as a deduction 
unless the amount was previously included in income.
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State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen flow to the tax computation on the “Wks Tax/Lic” worksheet. The state tax 
amount flowing from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used, and which tax type is selected.

Interest 

The “Interest” line of Form 1065 refers only to the interest incurred by the partnership 
in a trade or business activity that is not claimed elsewhere in the return.

Use the DED screen to enter interest expense amounts. Do not include interest 
expense on the following:

• Debt required to be allocated to the production of qualified property

• Debt used to buy rental property or debt used in a rental activity

• Debt used to purchase property held for investment

• Debt proceeds allocated to distributions made to partners during the tax year

Self-Charged 
Interest

Self-charged interest rules (see Form 1065 instructions) do not apply if a partnership 
elects under Reg. section 1.469-7(g) to avoid the application of them. If the partner-
ship is making this election, a statement must be included with the return.

To include the statement:

Screen Code: 
ELEC

1. Click the ELEC link on screen DED. (The ELEC screen is also available from 
the Miscellaneous tab of the Data Entry Menu.)

2. In the Election drop list, select 19 - Not Apply Alternative Treatment to Self-
Charged Items.

When the return is calculated, the statement (“Statement EL19” in View/Print mode; 
see Figure 1 on page 20), including the required text, will be included in the return.

NOTE
Credit from Form 8846, Credit for Employer Social Security and Medi-
care Taxes Paid on Certain Employee Tips, automatically adjusts the 
amount of taxes and licenses on Form 1065.
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Figure 1: Self-Charged Interest statement

For more information on self-charged interest rules, see the “Self-Charged Interest” 
section of the Form 1065 instructions.

Depreciation

Use screen 4562 to enter depreciable assets for Form 1065, Form 1125-A, Schedule F, 
Form 8825, the RENT screen (rental other than real estate), and Section 754. (To 
associate a depreciable asset with an activity, make a selection from the For drop list 
at the top of the 4562 screen.)

Using the 
DED screen 

for Direct 
Entry

As explained further in “Line 16, Depreciation,” following, the DED screen has two 
lines for direct entry of depreciation, both adjustment fields:

• Line 16a — Depreciation

• Line 16b — Depreciation claimed elsewhere on return

Any item entered in a depreciation field on the DED screen is added to the calcula-
tions from all 4562 screens. DED screen amounts are reflected on page 1 of Form 
1065 but are not shown on any generated Form 4562.

For more information on depreciation and the 4562 screen in Drake Tax, see the 2019 
Drake Tax User’s Manual.

Line 16, 
Depreciation

Line 16c of Form 1065 is reserved for depreciation that (1) is from Form 4562 and (2) 
is claimed elsewhere. While the program pulls data from the 4562 screen for this line, 

NOTE Using the ELEC screen for this statement does not prevent the return 
from being e-filed.

IMPORTANT The depreciation fields on any screen should be used 
only if Form 4562 is not required.
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it also provides field 16b (Figure 2) on screen DED specifically for depreciation that 
is claimed elsewhere.

Figure 2: Depreciation line 16 fields from DED screen

Both lines 16a and 16b on the DED screen are adjustment fields and add to or subtract 
from program calculations that are based on entries elsewhere in the program. Enter 
only the depreciation claimed on assets used in a trade or business activity:

• Line 16a — An entry here is added to the depreciation from the 4562 screens. The 
amount on line 16a is not reflected on Form 4562.

• Line 16b — Drake Tax recommends using screen A (rather than the DED screen) 
to enter depreciation claimed on Form 1125-A. An entry in the “Other costs - 
depreciation” line on screen A adjusts any entry on line 16b of the DED screen 
and is calculated into the total deductions on Form 1065. (An entry in the Other 
costs - depreciation line on screen A also overrides calculated amounts for 
entries on 4563 screens directed to COGS.) If there is an entry on line 16b of the 
DED screen but not screen A, only the line 16b amount is calculated into total 
deductions.

Section 754 Use screen 4562 to enter section 754 depreciation. To associate the depreciable asset 
with section 754, select “754” from the For drop list at the top of the screen.

For information on allocating Section 754 depreciation to specific partners, see “Spe-
cial Allocations” on page 35 and “Section 754 Allocations” on page 54.

Section 179 Section 179 expense is not included on Form 4562, line 22, nor is it carried to line 16a 
of Form 1065. It is instead reflected on line 12 of Schedule K and distributed to each 
partner on Schedule K-1.

Reclassify to 
Amortization

To reclassify an asset from depreciation to amortization:

1. Open screen 4562 for the asset.

2. From the Method drop list, select AMT - Amortization.

3. Complete the applicable fields in the Amortization section of screen 4562.

NOTE
Section 179 expense does not flow to page 1, “Depreciation,” of Form 
1065. It is reflected on Schedule K, “Net long-term capital gain,” and 
then distributed to each partner on Schedule K-1.
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Depletion

Enter depletion amounts on the DED screen. If the partnership claims a deduction for 
timber depletion, complete and attach Form T, Forest Activities Schedules, available 
from the IRS website. (Attach this form as a PDF document to e-filed returns. See 
“The PDF Attachment Process” on page 78.) Do not deduct depletion for oil and gas 
properties. Depletion should be figured for each partner on screen DEPL. See “Oil 
and Gas Depletion Worksheet” on page 45 for more on entering oil and gas depletion 
in the 1065 package.

Retirement Plans

Use the DED screen to enter amounts for line 18, “Retirement plans, etc.” See the IRS 
instructions for guidance on what costs are acceptable for this line.

IRA for 
Employees

If the partnership contributes to an IRA for employees, include the contributions in 
salaries and wages on either the DED screen (Salaries and wages line) or screen A 
(Cost of labor line).

Payments to 
Partners

Do not use line 18 of the DED screen to deduct payments for partners to retirement or 
deferred compensation plans, IRAs, qualified plans, Simplified Employee Pension 
(SEP), or SIMPLE IRA plans. Report these amounts, which are deducted by the part-
ners on their own returns, on screen K (Deductions tab), item 13d, code R. 

Employee Benefit Plans

Use the DED screen, line 19, to enter the partnership’s contributions to employee ben-
efits programs (such as insurance, health, and welfare programs) that are not part of a 
pension or profit-sharing plan included in line 18, “Retirement plans, etc.”

Amounts 
Paid for 

Medical Care

The line 19 amount should not include amounts paid for insurance that constitutes 
medical care for a partner, a partner’s spouse, or a partner’s dependents. For informa-
tion on entering amounts paid for medical care, see “Guaranteed Payments and Part-
ner Health Insurance” on page 17.

Pub. 541 IRS Pub. 541 states that premiums for health insurance paid by a partnership on behalf 
of a partner for services as a partner, are treated as guaranteed payments. The partner-
ship can deduct these payments as a business expense, and the partner must include 
them in gross income. The partnership cannot deduct the premiums, however, if the 
partnership accounts for insurance paid as a reduction in distributions for that partner. 

NOTE
The Depletion Worksheet in the Partnership package is for informa-
tional purposes only. Depletion is calculated in the partner’s individual 
returns.

NOTE
The program reduces the expense based on the credit amount calcu-
lated from Form 8881, Credit for Small Employer Pension Plan 
Startup Costs.
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In that case, go to the K1 screen for the partner and mark the Health Insurance dis-
tribution reduction box (line 13M) at the bottom of the screen.

A qualifying partner can deduct 100% of the health insurance as an adjustment to 
income. The partner cannot deduct the premiums for any calendar month, or part of a 
month, in which he or she is eligible to participate in any subsidized health plan main-
tained by the employer of the partner or the partner’s spouse.

Other Deductions

Enter all other deductions on the DED screen. Drake Tax calculates these amounts and 
incorporates the total into the “Other deductions” line of Form 1065.

The following deductions, credits, adjustments, and exclusions also flow to the “Other 
deductions” line:

• Amortization from Form 4562, Depreciation and Amortization

• Credit adjustment from Form 6765, Credit for Increasing Research Activities

• Credit adjustment from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Tax and Payments

In Drake Tax, the TAX screen is used to complete the “Tax and Payment” section of 
Form 1065. Payment of the tax depends on which line the tax is reported. Depending 
on the type of tax and the required payment, it is possible that the partnership could 
have to write separate checks to remit payment since there are separate form attach-
ments, payment types, and addresses listed for the different lines. There are no esti-
mated payment requirements at this time

Use the TAX screen to report the following data:

Line 23: “Interest due under the look-back method – completed long-term contracts.” 
Data entered on line 23 adjusts an amount flowing from Form 8697, Look-Back 
Method for Completed Long-Term Contracts.

Click the 8697 link on screen TAX to complete and generate Form 8697. Drake Tax e-
files Form 8697 with the 1065 return unless there is a refund of interest paid on certain 
long-term contracts, or if the form is being filed separately with a payment, in which 
case the form must be signed and then mailed:

• If a refund is due, select the Mark the box if filing this form separately check 
box on screen 8697, print the form, and after having it signed, mail it.

NOTE
Form 8697 is used to figure the interest due or to be refunded under the 
look-back method of section 460(b)(2) on certain long-term contracts 
that are accounted for under either the percentage of completion 
method or the percentage of completion-capitalized cost method. 
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• If making a payment of interest due, select the Mark the box if filing this form 
separately check box on screen 8697, print and sign the form, then mail the form 
with a check or money order for the full amount, made payable to “United States 
Treasury.” Write the partnership’s Employer Identification Number (EIN), day-
time phone number, and “Form 8697 Interest” on the check or money order.)

See Screen Help (press CTRL+ALT+? or select from a right-click menu) or the IRS 
instructions for Form 8697 for information on how and why to file Form 8697.

Line 24: Form 8866 is used to figure the interest due or to be refunded under the look-
back method of section 167(g)(2) for property placed in service after September 13, 
1995, that is depreciated under the income forecast method as described in section 
167(g).

Data entered on line 24 of the TAX screen adjusts an amount flowing from Form 
8866, Interest Computation Under the Look-Back Method for Property Depreciated 
Under the Income Forecast Method. To complete the form, click the 8866 link on 
screen TAX. Drake Tax e-files Form 8866 with the 1065 return unless there is a 
refund of interest paid, or if the form is being filed separately with a payment, in 
which case the form must be signed and then mailed:

• If a refund is due, select the Mark the box if filing this form separately check 
box on screen 8866, print the form, and after having it signed, mail it.

• If making a payment of interest due, select the Mark the box if filing this form 
separately check box on screen 8866, print and sign the form, then mail the form 
with a check or money order for the full amount, made payable to “United States 
Treasury.” Write the partnership’s Employer Identification Number (EIN), day-
time phone number, and “Form 8866 Interest” on the check or money order.)

See the IRS instructions for Form 8866 for information on how and why to file Form 
8866.

Line 25: “BBA AAR imputed underpayment.” Use this line if the partnership is filing 
an AAR electronically and chooses to pay the imputed underpayment. For instructions 
on how to figure the imputed underpayment, see the Instructions for Form 8082.

Write the name of the partnership, the tax identification number, tax year, “Form 
1065,” and “BBA AAR Imputed Underpayment” on the payment. Checks must be 
payable to “United States Treasury” and mailed to:

Ogden Service Center
Ogden, UT 84201-0011

Payments can be made by check or electronically.

Line 26: “Other taxes.” In a few rare instances, payments other than those listed 
above may have to be made with Form 1065. Enter a description of these payments 
and the amounts being paid in the Other Taxes text boxes on line 26 of screen TAX. 
In View/Print mode, “Statement TAX” lists these other taxes.
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Line 28: “Payment.” Enter on this line any prepayments related to lines 23-26 above. 
Data entered here adjusts an amount entered on screen 7004 screen for payments 
made with the extension.

Filing an Extension

Generally, a domestic partnership must file Form 1065 by the 15th day of the 3rd 
month following the date its tax year ended as shown at the top of Form 1065.

Calendar year returns are due on March 16, 2020. By filing Form 7004, a partnership 
can extend the deadline six months to September 15, 2020. Fiscal-year returns are due 
on the fifteenth day of the third month after the end of the fiscal year.

To file a 1065 extension, use one of the following options:

• Go to the 7004 screen in Drake Tax (Other Forms tab of the Data Entry Menu) 
and select Generate an extension. Complete any other applicable fields on the 
screen.

• Go to the PRNT screen and select Prepare a Form 7004 extension.

Signing the Return

PIN signatures are required for e-filed returns. To e-file a return, complete all fields on 
the PIN screen. A return cannot be e-filed if the PIN screen is not completed, includ-
ing title and signature (name) of the general partner or LLC member manager. (See 
“‘Signs Return’ Partner,” following.) A signing date and SSN of the signing person is 
also required.

“Signs 
Return” 
Partner

If the Signs return check box was selected for one of the partners on a K1 screen, that 
partner’s title, name, SSN, and phone number will be combined with the ERO’s PIN, 
the partner’s PIN, and the signing date on the PIN screen that must still be entered on 
the PIN screen in order to e-file the return. If the Signs return check box is not 
marked on any K1 screen, then the ERO PIN, Partner PIN, Signature date, Title, 
and Signature fields on the PIN screen must be completed manually.

Preparer’s 
Signature

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided on the PIN screen. If the return 
is prepared by a partner or an employee of the partnership, open screen 1 and select 
NONE in the Firm # and Preparer # drop lists.

To have the preparer’s signature displayed on the printed return:

• If the return preparer and ERO (entered in Setup > Electronic Filing & Account 
Information) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Enter the preparer’s PIN on the PIN screen for the return.

• If the return preparer and ERO are not the same, go to the PRNT screen and com-
plete the field labeled PIN for preparer’s alternative electronic signature. The 
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PIN entered should match the one entered for the preparer in Setup > Pre-
parer(s). (For more information, press F1 in this field.)

The optional Suffix drop list and Professional text box on the PIN screen allow you 
to add such designations as “Jr.”, “Sr.”, “III” to the name of the partner and such pro-
fessional designations as “Dr.” or “Ret.”

Missing PIN 
Information

If you receive a state EF Message stating, “Authentication Header,” check the SSN 
field on the PIN screen for a missing SSN. Also make sure the Title and Signature 
(name) fields for the partner signing the return are completed. (SSN is not required for 
federal returns.)

Form 
8879-PE

You must receive the completed and signed Form 8879-PE, IRS e-file Signature 
Authorization for Form 1065, before the return is e-filed. This form must be kept in 
the tax office for three years from the return due date or IRS received date, whichever 
is later.
To generate the filing instructions for Form 8879-PE, either:
• From the Home window of Drake Tax, go to Setup > Options > Client Commu-

nications tab and set the program to print the filing instructions for all returns

• Inside a return, open the PIN screen and mark the box to print the 8879-PE filing 
instructions for that return

The 8879-PE filing instructions will be listed in View/Print mode.

For information on using an electronic signature pad to digitally sign Form 8879-PE, 
see “Electronic Signatures” in Chapter 6, “Return Results,” of the 2019 Drake Tax 
User’s Manual.

Amending a Return

To file a 1065 return that has been amended:

1. Go to screen 1 in data entry and select Amended return in section G.

2. Make changes as applicable to forms and schedules.

3. Go to the EF screen and select Amended 1065 in the left-hand column.

4. Go to the SCH screen (available from the Miscellaneous tab of the Data Entry 
Menu) and complete the following fields:

• Statement number — Select 011 - Amended Return Statement.

NOTE
Setup > Electronic Filing & Account Information must still be com-
pleted in Drake Tax for e-file. For information on how to complete this 
setup window, see 2019 Drake Tax User’s Manual. See the IRS instruc-
tions for further details on signature requirements.

CAUTION

When you amend a return in Drake Tax, the amended informa-
tion replaces the original in the data file. Before amending a 
return, you should archive the original to avoid losing previ-
ously submitted data. For more information on archiving 
returns, see “Archive Manager” in Chapter 6, “Return Results,” 
in the 2019 Drake Tax User’s Manual.
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• Title — Enter a statement title of 28 or fewer characters.

• Explanation text box — Identify the amended items by line number and 
explain what was changed and why. 

If amending just the K-1s, go to each K1 screen, select Amended K1, and make 
needed changes.

TEFRA and Filing Eligibility

A partnership subject to the TEFRA (Tax Equity and Fiscal Responsibility Act of 
1982) audit rules cannot file an amended Form 1065 to correct a partnership item 
reported on a previously filed return, but according to these rules, the partnership rep-
resentative (PR) must file Form 8082 on the partnership’s behalf and request the IRS 
treat the Form 8082 as a substituted return. A partnership qualifying as a small part-
nership (see Section 6231(a)(1)(B)) – with 10 or fewer partners at any one time during 
the year – is exempt from the TEFRA audit rules and can file an amended Form 1065 
and corrected K-1s to partners.

Additional Information

This section covers Schedule B, “Other Information,” state-specific information, and 
some program overrides.

Schedules B, B-1, and B-2

The program has five screens for entering data for Schedule B, Other Information, 
Schedule B-1, Information on Partners Owning 50% or More of the Partnership, and 
Schedule B-2, Election Out of the Centralized Partnership Audit Regime:

• Screen B (Schedule B tab) — For lines 1 through 20 (excepting lines 2 and 3)

• Screen B (Schedule B cont. tab)— For lines 21 through 28 (excepting line 26) 
See “New for 2019,” following 

• Screen B1 — For lines 2a and 2b of Schedule B-1 (foreign ownership of the part-
nership). Much of the data on Schedule B-1 flows from entries on each partner’s 
K1 screen. See “Schedule B-1 Information” on page 28.

• Screen B2 — For Schedule B-2, electing out of an audit regime and listing share-
holders in an S corporation that is a partner in the partnership (See “Electing Out 
of Centralized Partnership Audit Regime” on page 30.)

NOTE
When amending a 1065 return, all K-1s are amended, and the 
“Amended K-1” box on the return is marked automatically. To override 
this default, go to the PRNT screen and mark Do NOT check amended 
box on Sch. K-1.

NOTE
If an entity and not an individual is selected as the partnership repre-
sentative on a K1 screen, additional data is required in the Designa-
tion of Partnership Representative section of screen B (Schedule B, 
cont. tab). 
Tax Year 2019 27



Additional Information Drake Tax Manual Supplement: 1065
• Screen B3 — For lines 3a and 3b of Schedule B (ownership of foreign companies 
by the partnership)

From screen B, you can access screens B1 and B3 by clicking the applicable links 
(Schedule B1 and Attachment 3a and 3b) or by pressing PAGE DOWN twice (for 
screen B1) or three times (for screen B3).

Schedule B-1 Information

Enter the required Schedule B-1 information – type of partner, country of organiza-
tion, percentage owned in profit, loss, or capital – on each partner’s K1 screen. (This 
information can also be entered on screen B1 screen.)

When you make a 
selection from the 
Country of Incor-
poration drop list in 
the Schedule B-1 
section (figure at 
left) of a K1 screen, 
and then make an 
entry in the Max 

Percentage Owned field, the program automatically answers questions 2a and 2b of 
Schedule B, and produces Schedule B-1, using the information entered on the K1 
screen—name, ID number, type of partner, ownership percentage—to complete Parts 
I or II (as appropriate).

Of course, you can continue to use the B1 screen if you prefer.

Foreign 
Ownership

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, 50% or more of the total voting power of all classes of stock entitled to vote 
of any foreign or domestic corporation, use the Line 3a section of screen B3 to enter 
the corporation’s name, EIN, country of incorporation, and percentage owned in vot-
ing stock. (From the B screen, click the Attachment 3a and 3b link.)

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital in any foreign or 
domestic partnership or in the beneficial interest of a trust, use the Line 3b section of 
screen B3 to enter the entity’s name, EIN, type, country of organization, and maxi-
mum percentage owned in profit, loss, or capital.

NEW FOR 

2019
• Line 27 of Schedule B is for the number of foreign partners subject to 

section 864(c)(8).

• Line 28 is for any transfers between the partnership and its partners 
subject to the disclosure requirements of Regulations section 1.707-8.

NOTE
Which screens are required depends on the percentage owned. See 
Form 1065 instructions for calculating the maximum percentage 
owned.
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Line 4 
Require-

ments

If question 4 on screen B is answered Yes, Schedules L, M-1, M-2, and Section L of 
Schedule K-1 are not required and therefore not printed. The four conditions that must 
be met in order to answer Yes to this question are:

• The partnership’s total receipts for the tax year were less than $250,000.

• The partnership’s total assets at the end of the tax year were less than $1,000,000.

• Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return.

• The partnership is not filing and is not required to file Schedule M-3.

The 4c check box on screen B allows you to indicate that the Schedules K-1 were not 
furnished to the partners on or before the due date of the partnership return while 
answering “Yes” to the other three parts.)

For more on line 4, see “Schedule L (Balance Sheets Per Books)” on page 56.

Partnership Representative

Partnerships must appoint a “partnership representative.” The partnership representa-
tive (PR) does not have to be a partner in the partnership but does have to possess a 
U.S. taxpayer ID number (TIN), and the address of the representative must be a U.S. 
address. This information is entered on the appropriate K1 screen (see the figure on 
the following page) or in the override fields on the Schedule B cont. tab of screen B.

The PR has “complete 
authority to act on behalf 
of the partnership” when 
dealing with the IRS. This 
includes legally binding 
the partnership (and there-
fore, the partners) in terms 
of audits and other IRS 
proceedings.

The Drake Tax program 
does not select a PR if one 
is not indicated on screen
K1 or the Schedule B 
cont. tab of screen B. An EF Message is generated, stopping e-file until a selection of 
a representative is made.

The same is true if more than one partner is indicated as the PR. An EF Message stops 
e-file until a single selection is made.

Indicate the person who will act as the representative using the PTR REP check box 
on screen K1 (figure above). The representative’s information is printed at the bottom 
of page 3 of Form 1065.

To change or revoke a previously selected partnership representative, click the 8979-
PR Revocation check box on the Schedule B cont. tab of screen B and complete 
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Form 8979, Partnership Representative Revocation, Designation, and Resignation 
Form.

Any information entered in the override fields of the Designation of Partnership 
Representative section of the Schedule B cont. tab of screen B overrides the PR elec-
tion made on a screen K1.

Reporting Limitation on Business Interest Expense

Every taxpayer who deducts business interest is required to file Form 8990, Limitation 
on Business Interest Expense Under Section 163(j), unless an exception for filing is 
met. Form 8990 is used to figure the amount of business interest expense the partner-
ship can deduct and the amount to be carried forward to the next year.

Screen code:
8990

If any of the criteria listed on line 24 of screen B (Schedule B, cont. tab) is met, mark 
the Yes check box on that line, then go to screen 8990, available through the Other 
Forms tab of the Data Entry Menu

A partnership is not required to file if it is a “small business taxpayer” and does not 
have excess business interest expense from another partnership. The partnership is 
also not required to file Form 8990 if it has only interest expense from these excepted 
trades or businesses:

• The trade or business of providing services as an employee

• An electing real property trade or business

• An electing farming business

• Certain utility business

A “small business taxpayer” is a taxpayer that is not a tax shelter and has average 
annual gross receipts of $25 million or less for the three prior tax years under the gross 
receipts test.

Before entering data in the fields on screen 8990, enter data all other screens needed to 
complete Form 1065. View the return (press CTRL + V) and note the “Ordinary busi-
ness income (loss)” on page 1, line 22 of Form 1065, then return to this screen and 
enter the taxable amount on line 6. Complete all other appropriate fields on this 
screen. 

Electing Out of Centralized Partnership Audit Regime

Question 25 of Schedule B (available on the Schedule B cont. tab) asks if the partner-
ship is electing out of the centralized partnership audit regime. If the answer is “Yes,” 
then Drake Tax generates Schedule B-2, Election Out of the Centralized Partnership 
Audit Regime, listing all partners in the partnership based on the information provided 
on the K1 screens in the program. (If any of these partners is a partnership, however, 

NOTE
If an entity and not an individual is selected as the Partnership Repre-
sentative on a K1 screen, additional data will be required in the Desig-
nation of Partnership Representative section of the Schedule B. 
cont. tab of screen B.
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or if the partnership has more than 100 partners, the partnership cannot elect out of the 
centralized partnership audit regime and is ineligible to use Schedule B-2.)

Screen Code: B2 If a partner in the partnership is an S corporation, all the shareholders of that corpora-
tion must be included in Part II of Schedule B-2. Those shareholders’ names, ID num-
bers, and their “type” must be entered on the Schedule B-2 screen (available through a 
link on the Schedule B cont. tab or from the Data Entry Menu). Each of these share-
holders count as a partner toward the 100-partner limit for the eligibility to elect out of 
the audit regime and eligibility to use Schedule B-2.

If the answer to question 25 is “No,” Drake Tax completes the “Designation of Part-
nership Representative” section at the bottom of Schedule B automatically, based on 
the K1 screens included in the return. (Information on the partnership representative 
also can be entered on the Schedule B cont. tab of screen B.)

Form 8996 and 8997, Qualified Opportunity Funds

Section 1400Z-2 provides partners investing eligible gains in Qualified Opportunity 
Funds (QOF) can “defer recognition of certain gains.”

Form 8996 In Drake Tax, click the link on line 26 of screen B (Schedule B cont. tab) to access 
screen 8996 to complete Form 8996, Qualified Opportunity Funds. The partnership 
files Form 8996 annually to report that the QOF meets the investment standard of sec-
tion 1400Z-2 or to figure the penalty if it fails to meet the investment standard.

See Form 8996 and its related instructions for more information.

Form 8997 An investor in a qualified opportunity fund (QOF) uses Form 8997, Initial and Annual 
Statement of Qualified Opportunity Fund (QOF) Investments, to inform the IRS of the 
QOF investments and deferred gains held at the beginning and end of the current tax 
year, as well as any capital gains deferred and invested in a QOF and QOF invest-
ments disposed of during the current tax year.

Eligible 
Foreign 

Entity

If the partner is an eligible foreign entity, one that would be treated as a C (1120) cor-
poration were it a domestic entity, select the B2 - Eligible foreign entity check box in 
the Type of Partner section (the middle of screen K1.) The partner will be labeled 
with the correct code in the “Type of Eligible Partner” column of Schedule B-2, Elec-
tion Out of the Centralized Partnership Audit Regime.

Form 8832, Entity Classification Election

Form 8832, Entity Classification Election, is used by a business entity to elect how it 
will be classified for federal tax purposes, as a corporation, a partnership, or an entity 
disregarded as separate from its owner. An eligible entity is classified for federal tax 
purposes under the default rules described below unless it files Form 8832 or Form 
2553, Election by a Small Business Corporation. The IRS uses the information 

NOTE Form 8996 must be mailed. It is not eligible for e-file. 
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entered on this form to establish the entity’s filing and reporting requirements for fed-
eral tax purposes.

In Drake Tax, screen 8832 is available on the Other Forms tab of the Data Entry 
Menu.

State-Specific Information

Resident 
State

The program automatically generates a return for the partnership’s resident state. Use 
screen 2 to enter company information as it should appear on the state return. (Access 
screen 2 from the States tab, or enter 2 in the selector field and press ENTER.)

Company information on screen 2 includes the type of return that applies for state pur-
poses (consolidated, composite, controlled group, multi-state) and state-specific dates 
and numbers for identification.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 for the alternative data for registered office, principal place 
of business, “Books in care of,” and general contact information for the partnership’s 
contact person.

Other States Data for other states must be entered in state data entry. To access state data entry, 
select the States tab from the Data Entry Menu and select the desired states for state-
specific screens (or type the two-letter state code in the selector field and press 
ENTER).

Multi-State 
Appor-

tionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment 
screen (accessible from the States tab or by entering APPT in the selector field and 
pressing ENTER). This screen (Figure 3 on page 33) provides one central location for 
entering all state apportionment information instead of having to open each needed 
state’s screen. 

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet (“Wks SA-SUM”) that can be used for verifying input, 
and a reconciliation worksheet (“Wks SA-REC”) that ties the total of the state 
amounts to the federal return figures. These worksheets are available in View/Print 
mode.

The individual state apportionment screens are still available in Drake19 but will be 
used to override data entered on the APPT screen.

NOTE The company information fields on screen 2 apply to the resident state 
only.
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Figure 3: APPT (Multi-State Apportionment) screen

APPT Screens The APPT screen is opened to the Sales tab. Links at the top of this screen take you to 
the Payroll, Property, and Additional Property information tabs for each state 
selected (Figure 3). These screens and their uses are listed in Table 1.

You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list on the Sales tab 
when using the reconciliation worksheet. Not every item appearing on the federal 

NOTE
Mark the Zero Apportionment check box (Figure 3) to add a state but 
not include any apportionment data. This will include the state on the 
apportionment summary worksheet (“Wks SA-SUM”), available through 
View/Print mode.

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter guaranteed payments to partners, salary, wage, com-
mission, labor, and repairs amounts for each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists

NOTE
The Ending amount entered on the Property and Addition Property 
tabs in 2018 became the Beginning amount for property on the APPT 
screen when the client’s return was updated in Drake19.
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return may be subject to multi-state apportionment. When you select OT, the data 
entered becomes a reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information flows to that state’s return.

Other Information and Overrides

Use screen 1 to enter the following additional information:

Resident State — If the partnership has a mailing address in one state but does busi-
ness in another, use the Resident state drop list to select the state in which the partner-
ship does business.

Drake Codes and Overrides — For information on miscellaneous codes, invoice 
numbers, and override fields, see the following sections of the 2019 Drake Tax User’s 
Manual:

– “Listing a Different Firm, Preparer, or ERO on a Return,” in Chapter 2, 
“Installation & Setup.”

– “Miscellaneous Codes,” in Chapter 5, “Return Preparation.”

Entity Name Control Override — Use this field only if your client has obtained a 
Name Control from the IRS.

Schedule K (Partners’ Distributive Share Items)

Use the K screens to enter data for Schedule K, Partners’ Distributive Share Items. 

Screen K is a “tabbed” screen with separate tabs (circled in Figure 4 on page 35) for 
data entry of income, deductions, credits, AMT and basis, and other information. 
There is also a tab for Analysis of Net Income.

NEW FOR 

2019

An option to Update Misc Codes on Screen 1, available during the 
update process (Last Year Data > Update Client 2018 to 2019) was 
added to the federal business packages. For more information on using 
these code fields, see “Miscellaneous Codes” in Chapter 5 of the 2019 
Drake Tax User’s Manual.

NOTE Note the screen K fields are primarily adjustment fields. Press F1 in a 
field to see what amounts are adjusted from elsewhere in the program.
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Figure 4: Screen K is tabbed (circled at the top of the screen)

Each of the tabs includes such “Other” items such as “Other” income and “Other” 
deductions, etc., allowing a detailed supplemental K-1 statement (Figure 5).

Figure 5: Detailed statements with Schedule K “Other” items

Special 
Allocations

Override the calculated amounts of Schedule K items on the SA (Special Allocation) 
screen, reached by clicking an SA link on screen K. Override the allocation of any of 
the items on screen K for any of the listed partners.

For example, in Figure 6 on page 36, the calculated allocation to the partners of Ordi-
nary dividends (item #1) of $123,342, is being overridden by Dollar Amount (#2). 
As the allocations are entered in the Dollar Amount column, the program shows the 
percentage of the total that equals the dollar amount allocated (#3). The program also 
keeps a running total of the allocated amounts and the amounts yet to be allocated 
(#4). To change from allocation by dollar amount to allocation by percentages, select 
Percentage (#5).
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Figure 6: Special Allocations (SA) screen

When you click an SA link from screens K, M1, M2, M32, or M33 (there are also SA 
links on screens L and 199A) to make a special allocation, and enter an amount or per-
centage on that SA screen, the screen link on the original K, M1, M2, M32, M33, L, 
or 199A screen changes color (Figure 7), making it easier to find those items that have 
been overridden.

Figure 7: The SA links change color to indicate entries 
were made on the SA screen

The “Other adjustments” field of Section L of the 
Schedules K-1 will be recalculated based on the 
overrides entered on the SA screen to reconcile the 
ending capital.

For more on the “Other” fields of screen M1, see 
““Other” Adjustments” on page 61.

NOTES

• As with most of the SA links in the program, to use these SA links, you
must first enter data on the screen, then save (close) the screen. 
Reopen the screen, and click the SA link to open the Special Alloca-
tions dialog box for the line you selected.

• When the return is calculated, any amounts remaining unallocated is 
allocated to the partners based on pro rata calculations of partners’ per
centage as entered on screen K1. Enter “0” (zero) for any partner to 
remove the partner from the pro rata distribution calculation.

• Section L of the Schedules K-1 is recalculated based on the overrides 
entered on the SA screen.
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.

Partners’ 
Capital 

Analysis

There are also links to the SA screen on screen M2. Use the SA screen in this instance 
to reconcile Schedule M-2, Analysis of Partners’ Capital, to the “Partner’s capital 
account analysis” in section L of Schedule K-1.

Property 
Distributions

There is also a link to screen SA on both screen 8825 and RENT to allow allocation of 
property or real estate rental income.

3468 
Amounts

The Special Partner Allocations for 3468 Amounts link at the top-right corner of 
screen 3468 opens screen Schedule K Line 20C for Form 3468, allowing you to allo-
cate investment credit amounts from Form 3468 to the partners.

Passing Through QBI Information

For tax years beginning after 2017, individuals, estates, and trusts that are partners in a 
partnership may be entitled to a deduction of up to 20 percent of their Qualified Busi-
ness Income (QBI) from a trade or business, plus 20 percent of qualified Real Estate 
Investment Trust (REIT) dividends and qualified Publicly Traded Partnership (PTP) 
income. The deduction is subject to multiple limitations (such as the type of trade or 
business, the taxpayer’s taxable income, the amount of W-2 wages paid with respect to 
the trade or business, and the unadjusted basis immediately after acquisition of quali-
fied property held by the trade or business) and can be taken in addition to the stan-
dard or itemized deductions.

Partnerships are not eligible for the QBI deduction; instead, they must pass the neces-
sary information through to their partners. The partnership must attach a statement to 
its Schedules K-1, separately identifying each trade or business, and using the same 
box numbers as shown on Schedule K-1, the amount of the following items:

• Section 199A QBI

• Rental Income (loss)

• Royalty Income (Loss)

• Section 1231 Gain (Loss)

• Other Income (Loss)

• Section 179

• Charitable Contributions

• Other Deductions

• W-2 wages

• Unadjusted basis of assets

• Qualified REIT dividends

• Qualified PTP income

• QBI allocable to qualified payments received from the specified cooperative

• Pass-through Domestic Production Activities Deduction (DPAD) under Section 
1099A(g) from a specified cooperative

NOTES
• SA screens should not be used for entering amounts on Schedule K.

• SA screens cannot be used for any Schedule K line with a zero balance
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Screen Code: 
199A or K199

So you can report this information, Drake Tax has included in the 1065 package 
screen 199A, Qualified Business Deduction by Activity. (Links to screen K199 take 
you to the same screen.) There are also the Qualified Business Income (QBI) Deduc-
tion sections on screens F, RENT, and 8825. Drake Tax automatically produces the 
required statements with each partner’s Schedule K-1.

New for 2019: A check box added to screen 199A allows you to override the amounts 
calculated and flowing to the QBI worksheets.

QBI Statements and Worksheets

(New for 2019) Drake Tax is including new worksheets with 1120S returns that report 
Qualified Business Income:

Statement A “Statement A – QBI Pass-through Entity Reporting” worksheet that includes Section 
199A items, will be attached to and filed with Schedules K-1 this year.

The “Qualified Business Income Information” worksheet – a summary of Statement A 
– will also be generated with the return. This worksheet will not be filed and is 
intended for the entity’s records.

Statement B “Statement B – QBI Pass-through Entity Aggregation Elections,” will be attached to 
and filed with Schedule K-1, and a “Qualified Business Income Aggregation” work-
sheet – a summary of Statement B – will be generated for entity’s records.

Statement C “Statement C – QBI Pass-through Entity Reporting,” will be attached to and filed with 
Schedule K-1, for patrons of specified agricultural and horticultural cooperatives. Cer-
tain patrons who conduct business through cooperatives may be able to include 
patronage dividends and similar amounts they receive from those cooperatives to cal-
culate their own QBI deduction.. Specified agricultural or horticultural cooperatives 
are allowed a Section 199A(g) deduction for income attributable to domestic produc-

NOTE

The program calculates relevant QBI information based on data 
entry. It is important that you review the calculated results and rely 
on your knowledge of this client's tax situation. The program 
assumes that the partnership operates as a single business entity 
and that all of the income on Form 1065, line 22, “Ordinary busi-
ness income (loss),” is Qualified Business Income for purposes of 
computing QBI deductions. If the amount on line 22 is from more 
than one trade or business, use screen 199A to allocate QBI, W-2 
wages paid, UBIA, REIT dividends, and PTP income among the 
separate trades or businesses. If any of the amount on line 22 is 
not QBI, (for example investment income) use screen N199 to 
report that amount, and the W-2 wages paid, UBIA, REIT divi-
dends, and PTP allocated to that income.

Most screens needed for reporting QBI — 199A, N199, PBAN, 
BAN — can be found on the Other Forms tab of the Data Entry 
Menu.
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tion activities, which is similar to the domestic production activities deduction under 
former Section 199 before its repeal by the TCJA.

Denoting Specified Service Trades or Businesses

Specified service trades or businesses are generally excluded from the definition of 
qualified trade or business. If the partnership is a Specified Service Trade or Business 
(SSTB), the partner could be subject to income limitations mentioned earlier; you 
must, therefore, mark the box on screen 1 denoting that this partnership is a “Specified 
Service Trade or Business,” if appropriate.

A specified service trade or business is any trade or business providing services in the 
fields of:

Also considered an SSTB:

• Any other trade or business where the taxpayer receives fees, compensation, or 
other income for endorsing products or services, for the use of the taxpayer's 
image, likeness, name, signature, voice, trademark, or any other symbols associ-
ated with the taxpayer’s identity, or for appearing at an event or on radio, televi-
sion, or another media format

• Investing and investment management

• Trading or dealing in securities, partnership interests, or commodities

Reporting Section 199A Items

Report the Section 199A items to be passed through to the partners on screen 199A, 
Qualified Business Income Deduction. On that screen, if the partnership operates 
more than one business, select 1065 from the For drop list; otherwise, select from the 
For drop list the screen (K1P or K1F) that this activity pertains to.

Screen Code: 
199A or K199

On each screen 199A (Figure 8 on page 40), type in the EIN and name of the business, 
and be sure to mark the Treat as a “specified service business,” where appropriate. 
Type the Section 199A income information in the appropriate fields. To allocate the 
amounts and activities to the various partners, click the SA links. If reporting income 
data from more than one trade or business, press PAGE DOWN to allocate the data 
among the separate trades or businesses.

Health Actuarial science Athletics

Law Performing arts Financial services

Accounting Consulting Brokerage services

NOTE

Report qualified business income from farms on screen F (Schedule F, 
Farm Income), in the Qualified Business Income section; for QBI from 
rental real estate, go to screen 8825 (Rental Real Estate); for QBI from 
rentals other than real estate, go to screen RENT (Rental Other Than 
Real Estate). These are all override fields; use them to override pro-
gram calculations.
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Figure 8: Qualified Business Income Deduction fields on screen 199A

For screens 8825, RENT, and F, select Yes or No from the QBI drop list if this activ-
ity is a trade or business. (If this return was updated from Drake ’18, the field should 
be completed for you.)

Safe Harbor for Rental Properties

A rental real estate enterprise can be treated as a trade or business for purposes of sec-
tion 199A deduction. To qualify for this safe harbor, the enterprise must meet several 
requirements, among them:

• If 250 or more hours of rental services are performed each year in respect to this 
enterprise

• If separate books and records are kept for the enterprise

• The taxpayer maintains contemporaneous records

Commercial and residential real estate may not be part of the same enterprise for pur-
poses of meeting this safe harbor.

Open screen 8825 for each rental property. In the Qualified Business Income (QBI) 
section at the bottom of the screen, select “N” from the This activity is a trade or 
business drop list. Make a selection from the Rental real estate meets “safe har-
bor”... drop list. The program produces the Rental Real Estate Safe Harbor worksheet 
(“QBI SAFE” in View/Print mode.)

IMPORTANT For details on each type of income, read the field helps for 
all the Section 199A items.

NOTE
If Form 1065 is filed with no Section 199A information in box 20 (code 
Z) of Schedules K and K-1, the IRS will assume that no QBI data was 
generated from this partnership and will not allow the QBI deduction on 
the partner’s individual return.
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If a rental doesn’t qualify for the Safe Harbor, it might still qualify for the 199A 
deduction.

For complete details, see IRS Notice 2019-07.

Aggregation and PBANs

On their Individual (1040) returns, partners have the choice to “aggregate” (or com-
bine) certain businesses into one entity for purposes of computing the Qualified Busi-
ness Income deduction (QBID). For that to happen, the partnership must tell the 
partners which trades or businesses qualify to be aggregated. This is done by using the 
PBAN fields.

Begin on screen 1 of the 1065 program. At the bottom of screen 1 is a field for enter-
ing a Potential Business Aggregation Number (PBAN).

A PBAN works just like other “grouping” numbers in Drake Tax, such as multi-form 
codes and passive activity numbers. All forms with the same number are grouped — 
or in the case, “aggregated.” (See “Associating One Screen with Another” in Chapter 
3 of the 2019 Drake Tax User’s Manual for more information on using multiform 
codes).

If this partnership potentially qualifies to be aggregated with any other businesses on 
this 1065 return, enter a number in the PBAN field on screen 1.

Enter this same 
number in the 
PBAN fields of 
every appropriate 
screen for each 
business on this 
return that poten-
tially could be 
aggregated — 
including the 
199A screen. (See “Reporting Section 199A Items” on page 39.) In the figure above 
(from screen 199A), this trade has been aggregated with others using PBAN “2.”

Screen Code: 
PBAN

Complete screen PBAN (available on the Other Forms tab of the Data Entry Menu) 
for each of the trades or business suggested for aggregation. Enter the proper PBAN 
and provide an explanation of the factors met that allow the aggregation in accordance 
with Regulations section 1.199A-4. Use the same PBAN for the PBAN screen as on 
the other screens of this aggregation.

Multiple trades or businesses can be aggregated into a single trade or business if they 
meet the following requirements:

• The taxpayer or a group of persons directly or indirectly own 50% or more of each 
trade or business for a majority of the tax year and all trades or businesses use the 
same tax year end.

• None of the trades or businesses is a specified service trade or business.

• The trades or businesses meet at least two of the following factors:
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– They provide products or services that are the same or that are customarily 
offered together.

– They share facilities or share significant centralized business elements such as 
personnel, accounting, legal, manufacturing, purchasing, human resources, or 
information technology resources.

– They are operated in coordination with, or reliance upon, one or more of the 
businesses in the aggregated group.

Screen Code: 
N199

If any portion of the income or loss calculated on line 22 of Form 1065 is not trade or 
business income for QBI deduction purposes, open screen N199 (available from the 
Other Forms tab of the Data Entry Menu), and allocate the portion of the item that 
should not be included on Schedule K-1, box 20, code Z.

Multiple 
Aggrega-

tions

It is possible to have more than one distinct aggregation group. To create a second 
aggregation, use another number in the PBAN fields of the second group. On the 
PBAN screen, press PAGE DOWN and include a description of the trade or business 
and an explanation of the factors met that allow the aggregation in accordance with 
Regulations section 1.199A-4. Use the second PBAN for this group.

Aggregated entities are listed in a statement with partners’ Schedules K-1.

Aggregation, BANs, and PBANs

A partnership engaged in more than one trade or business may choose to “aggregate” 
(combine) multiple trades or businesses into a single trade or business. In Drake Tax, 
use the Business Aggregation Number (BAN) fields to put these businesses together 
into one group or “aggregation.”

A BAN works just like other “grouping” numbers in Drake Tax, such as multiform 
codes and passive activity numbers. Enter the same number in the Business Aggrega-
tion Number (BAN) fields of the different businesses in the 1120S return – such as on 

NEW FOR 

2019

The BAN Statement B will be attached to each Schedule K-1 in returns 
with aggregated businesses.

Aggregated businesses will be reported in a single column of the Quali-
fied Business Income Information worksheet (Wks QBI) with the 
“Aggregation” box at the top right of the Statement A marked.

NOTE

Aggregation and the use of the Business Aggregation Number 
(BAN) fields is still under development. When programming and testing 
is complete, this functionality will be activated with a Drake Tax program 
update.

The PBAN (Potential Business Aggregation Number) functionality has 
been activated. See “Potential BANs” on page 43.

IMPORTANT

Once a partnership aggregates a group of trades or busi-
nesses, the individual partners must abide by that aggre-
gation. If the partners wish to choose their own 
aggregations, use the “Potential” Business Aggregation 
Number (PBAN) instead of the BAN. See “Potential 
BANs” on page 43 for more information.
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screens 1, F, 8825, RENT, and 199A – and all trades or businesses with the same 
BAN are aggregated. To create more than one aggregation group, use a different BAN 
for each separate group.

Using BAN 
Fields and 

Screen

If this partnership is engaged in more than one trade or business, and you determine 
that some of the separate businesses that are reported on this tax return qualify for 
aggregation, and the partnership wants to aggregate them, then enter the same number 
in the BAN fields of the different businesses in the 1065 return – such as on screens 1, 
F, 8825, RENT, and 199A, then open the BAN screen (located on the Other Forms 
tab of the Data Entry Menu).

Screen Code: 
BAN

Enter the same BAN in the Business Aggregation Number (BAN) field on the BAN 
screen that you used for the other business that you are aggregating (on screens 1, F, 
8825, RENT, or 199A). Then, type in a name for the aggregated group. Finally, in text 
box 1 on the BAN screen, describe the relationship between the businesses and the 
factors met that allow the aggregation.

If there has been any change on the aggregation since the 2018 return, then, in text box 
2 of the BAN screen, describe any changes in facts or circumstances that have 
occurred since the prior year relating to an existing aggregation of the trade or busi-
ness. (See the field help for both text boxes 1 and 2 for more information.)

To qualify for aggregation, the businesses must meet certain requirements (described 
in Publication 535 and in the field helps on screen BAN).

Potential 
BANs

On their Individual (1040) returns, partners in this partnership have the choice to 
aggregate certain businesses into one entity for purposes of computing the Qualified 
Business Income Deduction (QBID). For that to happen, the partnership must tell the 
partners which trades or businesses might qualify to be aggregated. This is done by 
using the PBAN (“Potential Business Aggregation Number”) fields on screens 1, F, 
8825, RENT, and 199A and the PBAN screen, available from the Other Forms tab of 
the Data Entry Menu.

The PBAN works just like the BAN and other “grouping” numbers in Drake Tax, such 
as multiform codes and passive activity numbers. All forms with the same PBAN can 
potentially be aggregated. (Partners can choose whether or not to aggregate and which 
trades or businesses can be in the aggregation. See the “IMPORTANT” note on page 
43.)

NOTE See “Associating One Screen with Another” in Chapter 3 of the 2019 
Drake Tax User’s Manual for more on using multiform codes.

NOTE
Enter the same aggregation number in the BAN field on screen 1 as 
you did in the BAN fields of the other trades and businesses of the 
aggregation if you want this partnership aggregated with the other 
trades and businesses.
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Enter this same number in the PBAN fields of every appropriate screen for each busi-
ness on this return that potentially could be aggregated — including 1, F, 8825, 
RENT, and 199A. (See “Reporting Section 199A Items” on page 39.) In Figure 9, this 
trade can potentially be aggregated with others also using the PBAN “3.”

Figure 9: BAN and PBAN fields on screen 199A

Screen Code: 
PBAN

Complete screen PBAN (available on the Other Forms tab of the Data Entry Menu) 
for each potential aggregation of the trades or businesses. Enter the proper PBAN and 
provide an explanation of the factors met that allow the aggregation in accordance 
with Regulations section 1.199A-4. Use the same PBAN for the PBAN screen as on 
the other screens of this aggregation.

If there could be two or more potential aggregations, press PAGE DOWN for a fresh 
PBAN screen.

Multiple trades or businesses can be aggregated into a single trade or business if they 
meet the following requirements:

• The taxpayer or a group of persons directly or indirectly own 50% or more of each 
trade or business for a majority of the tax year and all trades or businesses use the 
same tax year end.

• None of the trades or businesses is a specified service trade or business.

• The trades or business meet at least two of the following factors:

– They provide products or services that are the same or that are customarily 
offered together.

– They share facilities or share significant centralized business elements such as 
personnel, accounting, legal, manufacturing, purchasing, human resources, or 
information technology resources.

– They are operated in coordination with, or reliance upon, one or more of the 
businesses in the aggregated group.

Not 
Qualifying 

for QBI 

If any portion of the income or loss calculated on line 22 of Form 1065 is not trade or 
business income for QBI deduction purposes, open screen N199 (available from the 

NOTE
If this partnership potentially qualifies to be aggregated with any other 
businesses on this 1065 return, enter the same number in the PBAN 
field on screen 1 as you did on screen F, 8825, RENT, or 1099A for the 
other trades or businesses.
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Other Forms tab of the Data Entry Menu), and allocate the portion of the item that 
should not be included on Schedule K-1, box 17, code V.

Multiple 
Aggrega-

tions

It is possible to have more than one distinct aggregation group. To create a second 
aggregation, use another number in the PBAN fields of the second group. On the 
PBAN screen, press PAGE DOWN and include a description of the trade or business 
and an explanation of the factors met that allow the aggregation in accordance with 
Regulations section 1.199A-4. Use the second PBAN for this group.

Aggregated entities are listed in a statement with the partners’ Schedules K-1.

Oil and Gas Depletion Worksheet

The DEPL screen is accessible from the Other Forms tab of the Data Entry Menu. 
Create a separate depletion worksheet for each oil or gas interest. (Press PAGE DOWN 
to open a fresh instance of the DEPL screen.) Enter data for cost depletion, percentage 
depletion, or for both. If data for both cost and percentage depletion is entered, the 
program does both computations and sends the one that gives the taxpayer the best 
deduction to the proper form or schedule. (Not all taxpayers have the option of using 
either method. Consult Publication 535 for additional information.)

The deductions from all of the worksheets are totaled and carried to the indicated form 
or schedule.

Multiple Foreign Transactions

Screen Code: KFT Information on foreign transactions are entered on a separate KFT screen, accessible 
from the Foreign tab of the Data Entry Menu or from the Schedule K Foreign 
Transaction link on the Credits tab of screen K. Through the KFT screen, you can 
report multiple foreign transactions. (Press PAGE DOWN for a new KFT screen.)

Drake Tax generates a “Foreign Transaction Statement,” shown as “WK_FTRP~” in 
View/Print mode that lists all of the partnership’s foreign transactions. Separate For-
eign Transaction Statements (“K-1 STM FTR”) are generated for each partner, report-
ing these foreign transactions.

Business Activities Statement

A Business Activities Statement (screen BAS) allow you to break down a partner-
ship’s Schedule K items by business activity. The amounts and totals from the BAS 

NEW FOR 

2019

The BAN Statement B will be attached to each Schedule K-1 in returns 
with aggregated businesses.

Aggregated businesses will be reported in a single column of the Quali-
fied Business Income Information worksheet (Wks QBI) with the 
“Aggregation” box at the top right of the Statement A marked.

NOTE
The Depletion Worksheet (Wks DEPL) in the Partnership package is for 
informational purposes only. Depletion is calculated in the partner’s 
individual returns.
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l 

 
 

screen do not flow anywhere in the partnership return but do provide statements 
(listed on View/Print mode of “Wks BAS”) you can use as a reference when transfer-
ring these amounts into the partner’s 1040 return. A K-1 statement by business activ-
ity is also provided for the partners, listed on View/Print mode of “K-1 Wks BAS.” 
(Figure 10).

Figure 10: A partner’s Business Activities Statement in the 1065 package

Schedule K-1 for 1065 (Partner Information)

Use the K1 screen to enter data for Schedule K-1, Partner’s Share of Income, Credits, 
Deductions, etc.

Partner Type In the Type of Partner section, select the box on line G to describe the partner as 
either a General or LLC member-manager or a Limited or other LLC member 
(default is General).

On line H1, select either Domestic partner or Foreign partner (default is Domestic). 
On line H2, if the partner is holding the interest in the partnership as a disregarded 
entity (DE), enter the tax identification number (TIN) and name of the DE.

NOTES

• Type the name and address of the beneficial owner of the disregarded 
entity item F of screen K1. If the partner is a DE, the TIN of the beneficia
owner is entered, not that of the DE partner.

• For identity protection purposes, you can display only the last four digits
of the TIN. Type 000-00, then the final four digits of the ID number. Press
CTRL+F to “force” the program to accept the ID number.
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From the line I1 “PARTNER type” drop list (Figure 11), choose the type of partner 
(not the type of partnership). If this box is left blank, the program uses the default 
selection of Individual.

If the partnership is an eligible foreign entity, mark the B2 check box (Figure 11). See 
“Eligible Foreign Entity” on page 31. If the partner is a retirement plan (IRS, SEP, 
Keogh, etc.) mark the I2 check box.

Figure 11: Line I1 - K-1 Partner Type

Other Partner Information

Besides the PTR REP check box (see “Partnership Representative” on page 29), the 
Other Information section of the K1 screen offers a place to indicate which partner 
signs the return and which is the rounding partner. The Control number field gives 
you another sorting option. (See “Setting Sort Order of K-1s” on page 48 for more 
information.

Rounding 
Partner

Mark the Rounding Partner check box on screen K1 (figure below) to select which 
should be the rounding partner who receive any balancing amount on Schedule K-1 
when the return is calculated.

The Rounding Partner no longer is auto-
matically sent to the end of whatever sort 
order you’re using. If you do not make a 
selection, the program designates as the 
rounding partner the first partner you 
entered.

If you select more than one rounding part-
ner, the program generates a Return Note 
telling you that you’ve chosen more than 
one rounding partner, and also tells you 
which partners will be used as the rounding partner and which will be ignored.

Signs Return If the partner described on this K1 screen is the partner who signs the return for the 
partnership, mark the Signs Return check box (figure above), and a title for the sign-
ing partner in the Title for PIN Signature field (on line E of the screen). This part-
ner’s information will not have to be re-entered on the PIN screen. (The ERO PIN, 
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the “sign’s return” partner’s PIN, and the Signature date fields must still be com-
pleted on the PIN screen for the return to be eligible for e-file.)

Sorting and Viewing Schedules K-1

View a return with multiple Schedules K-1 
and you will see, in the forms “tree” on the 
left side of the View/Print window (in 
Enhanced View), that each partner has a 
“K1” folder (blue circle in figure at left) con-
taining Schedules K-1 and any other forms, 
worksheets, statements, and letters generated 
for that partner.

For those who print their K-1 forms from the 
Sets tab in View/Print mode, click the Sets 
tab and notice that each partner has a sepa-
rate folder containing all generated federal 
and state K-1 schedules, forms, and work-
sheets, making it easier to print everything 
needed for the partner (figure left.).

Click the PLUS SIGN [+] to expand the folder to see all documents relating to that part-
ner. Click the MINUS SIGN [-] to collapse the folder again.

Setting Sort 
Order of 

K-1s

For convenience when dealing with partnerships that have a large number of partners, 
you can sort the list of Schedules K-1 by recipient’s name, ID number, ownership per-
centage, or by the Control number.

The default sort order (as seen in View/Print mode) is determined by the order in 
which the partners are entered in the program. To select a new sort order, go to the 
PRNT screen (available through the General or Miscellaneous tabs of the Data 
Entry Menu) and, from the Sort K1s by drop list, choose:

• Control – Sort by the Control number entered on each screen K1 (See “Control 
Number,” following, for more.)

• ID – Sort numerically based on SSN or EIN of the partner

• Name – Choose to sort by first or last name and individual partners will be listed 
alphabetically by the name you choose. Partners that are businesses, estates, 
trusts, and tax-exempt organizations will be listed by the first letter of the first 
word or name in the Entity name line of screen K1.

• Percentage – Sort by the partner’s ownership percentage

Control 
Number

The Control number is an optional number the preparer can use to identify and sort 
Schedules K-1. The number can contain up to five digits and decimals are allowed. 
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Schedules K-1 can be sorted in View/Print mode by the control number from the 
PRNT screen. The control number is printed at the top of the Schedule K-1.

Grid Data Entry for Screen K1

If you have your program set up to take advantage of grid data entry, you can easily 
enter amounts in many of the most-often used lines of a Schedule K-1. This method is 
particularly useful for partnerships with a lot of partners.

First, initiate grid data entry:

1. Return to the Drake Tax Home window.

2. From the menu bar, select Setup > Options to open the Data Entry tab.

3. Near the bottom of the left-hand column, select Use grid data entry format on 
available screens. Click OK.

Now, open a return, and from the K-1 Information section of the General tab, click 
K1 to open the data-entry grid. To make entries in the grid:

1. Select a partner and click one of the fields where you wish to enter data.

2. Type information for that partner for that column.

3. Scroll across (or press the TAB key) to see more columns and make any entries 
needed.

4. Press the DOWN ARROW to make entries for other partners.

5. To open a partner’s K1 screen and make any other entries, select the line and click 
Item Detail (or press F3).

6. To return to the grid, close the partner’s K1 screen (or press F3).

IRS K-1 Codes

A code sheet can follow the printing of each Form 1065 K-1 to help the taxpayer inter-
pret the various codes used on Schedule K-1. To have this sheet printed with all K-1 
schedules, from the menu bar of Drake Tax’s Home window, go to Setup > Options > 
Form & Schedule Options tab and mark the Print Page 2 of Schedule K-1... check 

IMPORTANT
Drake Tax does not automatically “increment” the con-
trol number. You have to enter a unique number on 
each partner’s K1 screen.

NOTES

• You can arrange the grid by ID number, by partner’s first or last 
name, by Entity name (for partners that aren’t individuals), or by 
the amounts in the columns of the grid by clicking the column 
headers.

• Press F3 to toggle back and forth between grid data entry and a 
data entry screen.

• Right-click the grid and choose to export to an Excel or CSV file or 
print the grid. You can also resize the font to make the grid easier 
to read.
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box. The codes can also be printed on a return-by-return basis by marking the applica-
ble box on the PRNT screen. The code sheet is also available from Tools > Blank 
Forms.

Schedule K-1 may include asterisks with letter codes.

• An asterisk with a letter code indicates that multiple items have that code or that a 
statement is required for the code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and a statement is attached or that the state-
ment is required (as in the case of “other” amounts).

Returns with Numerous Partners

For returns with a large number of partners, you have the option of deactivating calcu-
lation and printing of the K-1 schedules while working on Form 1065. This option, 
which eases the process of reconciling the 1065, is available by going to the PRNT 
screen and marking the applicable box under K-1 Items to Suppress.

Partner Overrides

To override calculated amounts for the partners, you can either make changes on each 
K1 screen or go to one of the SA screens for partner special allocations and make all 
changes there. For more information, see “Special Allocations” on page 35.

Foreign Addresses

If the partner has a foreign address, enter the Province/ State, Country, and Postal 
Code information in the Foreign ONLY address line of the Partner Name and 
Address Information section of screen K1 (along with the street address and city in 
the Address and City fields in section F.) Do not enter anything in the State or ZIP 
fields. Conversely, for a U.S. address, do not enter anything into the foreign address 
fields.

NOTE Code sheets are now displayed in View/Print forms tree as “Schedule 
K-1 Code.”

NOTE After completing the K-1 entries for all partners, be sure to reactivate 
the calculation and printing of the K-1s from the PRNT screen.

NOTE
The Foreign ONLY fields are locked when a return is opened. Click 
one of the fields to unlock them throughout the return. To relock the 
unused Foreign ONLY fields, close and then reopen the return.
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Ownership Changes

All ownership change information is entered on the OWN screen, which is available 
from the General tab of the Data Entry Menu. To use the OWN screen:

• At the top of the screen, enter the date the profit, loss, or capital interest in the 
partnership was exchanged by two or more partners. If profit, loss, and capital are 
all involved in a transaction, put the date in the Profit/Loss/Capital field only. 
The Loss and Capital date fields are override fields, provided in case the loss or 
capital dates are different.

• In the Change in Percentages section, select the applicable partner from the drop 
list. (The drop list contains the names and ID numbers of all partners entered on a 
K1 screen).

• Enter the percentage changes in profit, loss, or capital as positive amounts for 
increases and negative amounts for decreases. (See field-level help for more infor-
mation.)

• To enter additional ownership changes, press PAGE DOWN.

Printed Data A Summary of Change in Ownership worksheet (“Wks POWN”) is generated when 
the return is viewed. The “Wks POWN” worksheet contains a list all partners and the 
ownership percentages and changes.

K-1 Export

Take the following steps to export a Schedule K-1 to another return:

1. Ensure that K-1 data is entered in the exporting 1065 return and that the recipient 
return has been created in Drake Tax. (The K1P screen in the other return does not 
have to be created beforehand.)

2. In the exporting 1065 return, go to View/Print mode.

3. Click K1 Export in the View/Print mode toolbar. A list of SSNs that cannot be 
exported appears, if applicable. (The reason a K-1 is ineligible for export appears 
in the Reason column.) Click Next.

4. The Export K1s dialog box (Figure 12 on page 52) lists all client SSNs that can 
be exported. (To prevent a Schedule K-1 in this list from being exported, remove 
the check mark to the left of it.)

NOTE See FAQ item “P” in the program for more information on entering 
ownership-change information.
Tax Year 2019 51



Schedule K-1 for 1065 (Partner Information) Drake Tax Manual Supplement: 1065
Figure 12: SSNs ready to be exported

5. Click Export. The K-1 data now appears on the partner’s 1040 tax return.

The K-1 Export feature can export K-1 data from partnership or fiduciary returns into 
the K-1 “source” screens (K1P and K1F) of the 1065 package.

An Additional Entries tab (Figure 13) offers 40 more fields for entering additional 
K-1 item.

Figure 13: Additional Entries tab of K1P screen featuring
40 additional drop lists and amount fields

Supplemental Information

Two types of supplemental information can be added to Schedules K-1:

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake Tax; this information cannot be exported from the 
1065 package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.
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• Supplemental data for all K-1s in a return

• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s) enter the information in the 
Supplemental Information block of screen K1G. Select Global Supplemental 
Statement Information from the Select Type drop list, then type in the information 
in the large text box below. The information appears in all partners’ Schedule K-1 
Supplemental Information statements.

To add supplemental information to an individual K-1 statement, open a partner’s K1 
screen and click the Supplemental Info link at the top of the screen. In the Supple-
mental Information pane (Figure 14), enter information pertinent to the partner. The 
information appears in only that partner’s Schedule K-1 Supplemental Information 
statement.

Figure 14: In this example, the information entered on the K1 screen appears on only
partner Amelia Carter’s Schedule K-1 Supplemental Information statement. 

Item M Question

If the answer to Schedule K-1, item M (“Did the partner contribute property with a 
built-in gain or loss?”), is “Yes” for all partners:

1. On the PRNT screen, select Yes in the Item M on Schedule K-1 section.

2. On screen K1G, select K1M - Built in Gain Loss Statement from the drop list, 
and type any supplemental information needed in the text box below.

If the answer is “Yes” for some partners but not others, use the individual partners’ 
Item M screens to report the supplemental information. The Item M screen is 
accessed by clicking the 8805/Item M tab at the top of any partner’s K1 screen. The 
supplemental information should list each property the partner contributed, the date 
the property was contributed, and the amount of the property’s built-in gain or loss.
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Partner’s Adjusted Basis Worksheet

Use the Partner’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a part-
ner’s new basis after increases or decreases are made to basis during the current year. 
A partner’s adjusted (outside) basis refers to the partner’s investment in a partnership. 
The basis is determined without considering any amount shown in the partnership 
books as capital, equity, or similar account. When a partner disposes of an interest in a 
partnership, the difference between the sale price and the adjusted basis is the taxable 
gain or loss.

The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a partner. (Access the K1 screen from the Data Entry Menu.)

Annual 
Update of 

Partner 
Information

When the program is updated in 2020, the 2019 end-of-year basis and liability 
amounts are automatically updated to the 2020 beginning of the year amounts. Any 
loss or deduction carryover is updated to the beginning of the year and its character 
(ordinary loss, section 179 expense, charitable contributions, etc.) maintained.

Special 
Allocations

Use the SA screens to allocate liability, capital, and K-1 Part III (Income, Deductions, 
Credits, and Other Items) amounts to individual partners without having to enter the 
information into each K-1 separately. Amounts can be entered as dollar amounts or 
percentages. Calculations from the SA screens flow to the appropriate fields of each 
individual K-1.

For information on the SA screens, see “Special Allocations” on page 35.

Section 754 
Allocations

To allocate section 754 depreciation among specific partners:

1. Open screen 4562 for each asset for which you plan to allocate section 754 depre-
ciation.

2. Select 754 from the For drop list at the top of each screen 4562.

3. Open screen K and click the Deductions tab.

4. Click the SA link on line 13d, item W, “Section 754 depreciation...” line. (See 
“Special Allocations” on page 35 for details on using the SA screen.)

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake Tax; this information cannot be exported from the 
1065 package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.

NOTE The Basis Worksheet (“Wks Adj Basis”) is printed only when the option 
is selected on the PRNT screen.

NOTE If a K1 screen is marked as Final K-1, none of the related screens for 
that partner is updated for the next year.
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Domestic Production Activities Deduction

The Domestic Production Activities Deduction (DPAD) has been repealed for tax 
years beginning after 2017, with limited exceptions. For those exceptions, the 8903 
screen, used to complete Form 8903, Domestic Production Activities Deduction, is 
still accessible from the Other Forms tab of the Data Entry Menu.

K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

Producing 
Letters for 

All Returns

To have the K-1 cover letters produced automatically with all applicable returns, from 
the Home window menu bar of Drake Tax, go to Setup > Options > Client Commu-
nications tab and mark the box labeled Include K-1 letter with returns. Click OK, 
then open a return.

Screen Codes: 
COMM or K1L

The signature used on the letter flows from the PIN screen. You can override this 
name on the K-1 letters by going to the K1L screen (also the COMM screen, both 
available from the Miscellaneous tab of the Data Entry Menu) and, in the K-1 
Cover Letter section at the bottom of the screen, entering a name and title of the per-
son’s signature you wish to use. 

Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window menu bar, select Setup > Communications Editor. The 
Client Communications Editor is displayed.

2. Select Open > Partnership > Partnership K1 Cover Letter to view the tem-
plate of the partnership K-1 letter.

3. Make any desired changes to the template.

NOTE
The program uses the name of the partner who signs the return 
(selected as the Signs return partner on the K1 screen) as the signa-
tory of the K-1 letter. Override this name with entries on either the PIN 
screen or COMM (or K1L) screen. The COMM screen entries override 
entries from either the PIN screen or the K1 screen.

TIP
Review the following sections of the 2019 Drake Tax User’s Manual before 
making changes to letter templates:

• “Introduction to Letters in Drake Tax” in Chapter 2, Installation & Setup

• The “Letter Keywords” section of Appendix B, Keywords
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4. Click Save.

Other K-1 
Letter 

Options

By default, the partnership’s name and address appear in the letterhead of the K-1 
cover letters, the information flowing from screen 1. (This assumes you first went to 
Setup > Communications Editor > Setup > Page Layout and selected the Use let-
terhead on letters box; otherwise, no header would be printed.)

Screen Codes: 
COMM or K1L

(optional) To have your firm’s contact information and logo printed in the letterhead of 
the K-1 cover letters, go the COMM screen (available from the Miscellaneous tab of 
the Data Entry Menu), and from the Information on the K-1 coversheet... drop list 
at the bottom of the screen, select F - Print firm info/logo.

(optional) To prevent the partnership’s or the firm’s name and address from appearing 
in the header of the K-1 letter, select X - Do not print entity or firm info from the 
Information on the K-1 coversheet... drop list at the bottom of the COMM screen.

Once the required signing information has been selected, a K-1 cover letter will be 
generated for each partner receiving a Schedule K-1.

To change the firm’s letterhead information, from the Home window menu bar, select 
Setup > Communications Editor. Select Open > Partnership > Letterhead (all 
packages) and make whatever changes you wish. Click Save. 

Schedule L (Balance Sheets Per Books)

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2 
to facilitate reconciliation of the balance sheet (item #1 in Figure 15 on page 57).

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended Schedule K-1. To edit the letter for an amended K-1, from the 
Client Communications Editor toolbar, select Open > Partnership > 
Partnership K1 Amended Letter and follow steps 3 and 4 of the previ-
ous procedure.

NOTE Changes made to the letterhead affects the letterhead for letters in all 
packages.

TIP
For more on working with letterheads, see “Setting Up Letterheads, 
Logos, Footers, Margins, and Borders” in Chapter 2 of 2019 Drake Tax 
User’s Manual.
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Figure 15: Beginning- and End-of-Year totals displayed on L screen (#1);
force-printing end-of-year totals (#2); link to SCH2 screen (#3); 

force-printing Schedule L and M-1 (#4)

Note that the totals from the balance sheet’s subsidiary schedule (SCH2 screen link, 
item #3 in Figure 15) also appear in the BOY Totals and EOY Totals columns of the 
L screen.

If you make any changes to the data, recalculate the return (press CTRL+C) for those 
changes to be displayed on the screen.

Schedule L is not required if:

• The partnership’s total receipts for the tax year were less than $250,000

• The partnership’s total assets at the end of the tax year were less than $1 million

• Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return

• The partnership is not filing, and is not required to file, Schedule M-3

If the partnership meets all four of these conditions, go to screen B and select Yes for 
line 4. Because Schedules L, M-1, M-2, and section L of Schedule K-1 are not 
required, they will not be generated with the return. To force the program to generate 
these items, click the Force-print Schedule L and M-1 link on the L screen (see item 
#4 in Figure 15) to open the PRNT screen. In the Items to Print section, select Force 
Schedules L, M-1, M-2, & K-1 Section L.

If any of the four conditions is not met, select No for line 4 on screen B. Schedules L, 
M-1, M-2, and Item L of Schedule K-1 are required and will be generated with the 
return.

TIP To speed up calculation of returns that contain multiple states, open 
screen 1 and select 0 from the Resident state drop list.
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Print End of 
Year Totals

If the Final return check box is marked on screen 1, you can select the Force-print 
final end of year check box (see item #2 in Figure 15 on page 57) to keep the pro-
gram from “zeroing out” the end-of-year totals.

Print 
Section L

You can “force” the program to generate the K-1 section “L” information without gen-
erating any unnecessary Schedules L, M-2, and M-2.

From the PRNT screen (available from the Miscellaneous tab of the Data Entry 
Menu), select Force Schedule K-1 Section L only and any available data is gener-
ated in the “L” section, “Partner’s Capital Account Analysis,” of Schedule K-1 
(Figure 16).

Figure 16: Section L information on Schedule K-1

Flow of Information

Many entries made elsewhere on the return (for example, inventory information on 
screen A) flow to the generated Schedule L of Form 1065. Depreciable asset informa-
tion, intangible assets, and amortization from the 4562 screen also flow to Schedule L. 

Direct entries on screen L include beginning- and end-of-year Cash, Trade notes and 
accounts received, bad debts, U.S. government securities, tax exempt securities, 
loans to partners, mortgage/real estate loans, depletable assets, and accumulated 
depletion. Other Schedule L data not entered on screen L comes from the partner-
ships’ income statement, balance sheet, and equity and capital accounts.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, indicating that this as a final-year return for 
a partnership, Drake Tax “zeros out” the EOY Totals column of Schedule L. Mark the 
Force-print final end of year check box on screen L (see item #2 in Figure 15 on 
page 57) to display those totals in the EOY Totals column.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
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Drake Tax. In other words, if you use this screen for all applicable lines on Schedule 
L, you do not need to make any entries on the L screen.

To create a statement for a line, select the line from the drop list (see Figure 17) and 
enter descriptions and their corresponding amounts. Once the information is entered, 
or if additional descriptions are required for the line, press PAGE DOWN to access a 
new screen.

Statements The total amounts entered on the SCH2 screen do not appear on the L screen in the 
program. They are, however, printed on the return where applicable, with references 
to the corresponding statements.

Note that an e-fileable “STATEMENT” is referenced in the return (Figure 17).

Figure 17: Data entered as “Other Current Assets” from the drop list on screen SCH2 will be 
included as an e-fileable statement and referenced on the applicable line of the return.

SCH2 and 
Trial Balance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If using 
Drake Tax’s trial balance import feature, be aware that SCH2 data cannot be entered 
directly into the trial balance worksheet, as it cannot be imported into the data entry. 
SCH2 detail screens must be created apart from the trial balance worksheet.

NOTES

All line selections are carried to the next-year program when the 
return is updated. Screen descriptions are updated, with the year-
end amounts from one year carried to the beginning-of-year column 
of the next year.

To access the SCH2 screen from the L screen, click the SCH2 
screen links on lines 6, 8, 13, 17, or 20 (or click inside a field and 
press CTRL+2).
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When the return is produced, Schedule L reflects the amounts imported from the trial
 balance worksheets (where direct entry was allowed). For more information, see 
“SCH2 Detail” on page 88.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the capital account on Schedule L by the difference 
between the total assets and the total liabilities and capital before the adjustment.

(Example: If Assets = $1,000 and Liabilities and Capital = $900, the program 
increases the partners’ capital accounts by $100.)

To deactivate this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Schedule M-2 (Analysis of Partners’ Capital Accounts)

Schedule M-2 is used to show what caused changes during the year in the partners’ 
capital accounts. The amounts on Schedule M-2 should equal the total amounts 
reported in item L of all the partners’ Schedules K-1.

Amounts entered for item L in the Partner’s Capital Account Analysis section on 
the partners’ K1 screen of Drake Tax flow to Form 1065, Schedule M-2, line 1, “Bal-
ance at beginning of year.”

Schedules M-1, M-3 (Reconciliation of Income)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total 
assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages 
1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with the taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable, as 
described in Table 2:

Table 2: Examples of Book-to-Tax Difference for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest
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 “Other” 
Adjustments

Open the Schedule M1 Other Adjustments screen to make adjustments to Section L, 
“Partner's capital account analysis,” of the partners’ Schedule K-1. To open the 
Schedule M1 Other Adjustments screen, click a blue Other link (circled in 
Figure 18) on lines 2, 4, 6 or 7 of screen M1.

Figure 18: Other screen links from screen M1

On the Other screen, enter a Description and an Amount and close the screen. When 
you calculate the return, the amounts entered on the Other screens have adjusted Sec-
tion L of the Schedules K-1.

Depreciation 
and 

Amortization 
Adjustments

The program may make an adjustment for book-to-tax depreciation differences. The 
calculation is done with the following steps. (This procedure refers to “depreciation” 
throughout, but it applies for either depreciation or amortization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated deprecia-
tion (line 9b, column a) (line 10b is “accumulated depletion”), is subtracted from 

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation
- Gains or losses on the sale of 

depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment

Table 2: Examples of Book-to-Tax Difference for Schedule M-1

Difference Description Examples

NOTES

If you enter an amount in the line 2, 4, 6, or 7 override fields on 
screen M1, and enter that amount again on the Other screen, the 
amounts will be added and the total will flow to Schedule M-1. (Only 
the amount entered on the Other screen affects Section L of Sched-
ule K-1, however.)

To allocate these adjusted amount to the partners, click the SA link on 
the right side of the Amount field on the Other screen. For more on 
using the Special Allocation (SA) screens, see “Special Allocations” 
on page 35.
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the “End of Year” accumulated depreciation (line 9b, column c). This is the 
“book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is the depreciation amount reported on the return, 
including any section 179 amounts).

3. The differences between the “book” and “tax” depreciation amounts are carried to 
the appropriate form and line.

• If the “book” depreciation amount is greater than the “tax” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 4a

– Schedule M-3, Part III, line 25, as a negative amount

– Form 8916-A, line 2(L), as a negative amount for assets selected on the 
4562 detail screen for COGS

• If the “tax” depreciation amount is greater than the “book” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 7a

– Schedule M-3, Part III, line 25, as a positive amount

– Form 8916-A, line 2(L), as a positive amount for assets selected on the 
4562 detail screen for COGS

Schedule M-3

The Schedule M-3 section of the Data Entry Menu includes direct access to the var-
ious M3 screens (Figure 19).

Figure 19: Data Entry Menu for M and M-3 schedules

If a domestic partnership reports on Form 1065, Schedule L, that its total assets at the 
end of its tax year equal or exceed $10 million (or that its gross receipts equal or 
exceed $250,000), it must complete and file Schedule M-3 instead of Schedule M-1.

NOTES

The program calculates total assets based on IRS requirements. 
For more information, see the Adjusted Total Assets Worksheet 
produced with the return and available in View/Print mode.

Some calculated amounts flow automatically to M-3; some data 
must be manually entered on the M3 screen. Review all amounts 
on the M-3.
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Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the 
tax return (per Schedule M-3, Part I, line 11) to net income (loss) on Form 1065, page 
5, “Analysis of Net Income (Loss),” line 1.

If the partnership is required to file (or voluntarily files) Schedule M-3, the partnership 
must file Form 1065 and all attachments and schedules, including Schedule M-3. 
Additional information could be required on the 8916 and SCH3 screens.

Force-Printing Schedule M-3

Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the 
year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the 
total assets equal or exceed $50 million. If the corporation’s assets do not equal or 
exceed $10 million but you want to voluntarily file Schedule M-3, or if the corpora-
tion’s assets do not equal or exceed $50 million and you wish to file the complete 
M-3, go to screen M3 and make a selection from the Force print schedule M-3 drop 
list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

See “Schedules M-1, M-3 (Reconciliation of Income)” on page 60 for more details on 
these schedules.

SCH3 
Screen

The SCH3 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule M-3 (or Form 8916-A). This screen can be used in place of the 
actual M3 screen in Drake Tax. In other words, if you use this screen for all applicable 
lines on Schedule M-3 or Form 8916-A, you do not need to make any entries on the 
M3 and 8916 screens. The total amounts entered on the SCH3 screen do not show up 
on the actual M3 and 8916 screens in the program; those amounts are printed, how-
ever, on the return, as applicable, with references to the corresponding statements.

To create a statement for a line, select the desired line from the Select line number 
from drop list on screen SCH3, then enter descriptions and their corresponding 
amounts. Once the information is entered, or if additional descriptions are required for 
the line, press PAGE DOWN to access a new screen (make the same selection from the 
Select line number... drop list.)

As with the SCH2 screen, the type of statement produced by the program depends on 
the line selected on the SCH3 screen and the IRS requirements. See “The SCH2 
Screen” on page 58 for more information on how to use the SCH3 screen.

Allocating 
M-3 Items

The SA links on screens M32 and M33 (Parts II and III) for Schedule M-3 allow you 
to allocate to the partners any Temporary Differences and Permanent Differences for 
income items (screen M32) and expense items (screen M33).

IMPORTANT
The program does not autobalance Schedule M-3. Addi-
tional data entry is required on screen M32, line 25, to 
reconcile with the analysis of net income.

NOTE All line selections flow to the next-year program when the return is 
updated. 
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As with most of the SA links in the program, to use these SA links, you must first 
enter data on the screen, then save (close) the screen. Reopen the screen, and click the 
SA link to open the Special Allocations dialog box for the line you selected.

See “Special Allocations” on page 35 for details on using the SA links.

Rental Activities
Screen code: 8825 Income and expenses for rental real estate properties appear on Form 8825, Rental 

Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake Tax, use the 8825 screen, available from the Other Forms tab of the 
Data Entry Menu. (Grid data entry is available. See “Grid Data Entry for Screen K1” 
on page 49 for details on using this feature.)

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 
reports each property’s information on a separate column of Form 8825. Data from all 
8825 screens are transmitted to the IRS when the return is e-filed.

Line 14, Depreciation

If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on the 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake Tax program, and then the 
net results should be entered on screen 8825. Line 14 of the 8825 screen is an adjust-
ment field: any amount entered on line 14 is added to the depreciation calculated from 
the 4562 screens.

Information 
Flowing to 
Form 8825

To indicate that the information should flow to Form 8825, select 8825 from the For 
drop list on screen 4562 (Figure 20). If there are multiple 8825 screens, use the Multi-
form code box. For information on using the Multi-form code box, see the 2019 
Drake Tax User’s Manual.

Figure 20: In this example, the program sends the 4562 information
to the third 8825 screen created.

NOTE Special steps are required if using the trial balance worksheet for mul-
tiple rentals. See “Rental Expenses” on page 89 for more information.

NOTES
• For assets placed in service during the year, Form 4562 is required.

• Drake Tax produces one Form 4562 for each property on Schedule E 
and Form 8825 instead of one 4562 per Schedule E or 8825.
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Any depreciation information entered on the 4562 screen flows to the correct Form 
8825, based on the form and multi-form code selections at the top of the 4562 detail 
screens.

Information 
Flowing from 

Form 4797 

If the corporation sold rental property, and screen 4797 is completed, data flows from 
Part II, line 17 of Form 4797, to the first Form 8825, line 19, “Net gain (loss) from 
Form 4797, Part II, line 17, from the disposition of property from rental real estate 
activities.”

Line 15, Other Expenses 

For rental properties with an “other” expense (line 15 of Form 8825), enter the amount 
of guaranteed payments, health insurance payments, and meals in the appropriate 
fields of the 8825 screen (see figure on next page). For rental properties with expenses 
not listed, enter those amounts in the Additional other expenses field. (An entry in 
this field opens a Detail Worksheet. Enter a description in the Description field and an 
amount in the Amount field.) The shaded field indicates a worksheet was entered.

Totals from the worksheet flow to Form 8825, and a statement from each property is 
printed with the return and transmitted to the IRS when the return in transmitted.

Enter rental income the partnership receives on a Schedule K-1 on the K1P screen. 
This amount flows to Form 8825, lines 20a and 20b. No entry is required on the 8825.

IMPORTANT

When selecting a multi-form code, note that the code 
should refer to an 8825 screen—not the 8825 form. For 
example, data from the third 8825 screen is generated on 
the first Form 8825. To associate an asset with that infor-
mation, you would type a “3” for the screen (not a “1” for 
the form) in the Multi-form code box. For more informa-
tion on Form 8825, see “Viewing Rental Activity Informa-
tion” on page 66.

NOTE

• Entries in the “Guaranteed payments” field and “Health Insurance pay-
ments” field on line 15 do not flow to line 10 of Form 1065 but do flow 
to Form 8825 and adjust the amounts on lines 2 and 4 of Schedule K.

• New for 2019: Be sure to take note of the “Services” and “Capital” 
fields on the “Guaranteed payments” line. These amounts are now 
reported separately on Schedule K-1.
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Qualified Business Income on Screen 8825

If this rental activity is a trade or a business, select “Yes” from the This activity is a 
trade or business drop list in the Qualified Business Income (QBI) section of the 
8825 screen. For a possible aggregation of business for the partners’ individual 
returns, type an appropriate number in the Potential Business Aggregation Number 
field. For more information on using these fields, see “Passing Through QBI Informa-
tion” on page 37 and “Aggregation and PBANs” on page 41.

Viewing Rental Activity Information

Rental activity data is reported on the 8825 forms and accompanying statements.

• 8825 Forms — Form 8825 can contain information for up to eight rental activi-
ties. If more than four rental activities are entered, a second page of Form 8825 is 
generated. If more than eight rental activities are entered, a second Form 8825 is 
created (figure at right).

• 8825 Statements — Statements are 
titled “Statement 8x,” (or “STM 
8X, depending on your Setup 
options) where “X” equals “A” to 
“H” for the first Form 8825. (For 
example, the statements for the 
first and second 8825 screens 
would be labeled “Statement 8A” 
and “Statement 8B,” respectively.) 
(See Figure 21, below.)

Figure 21: 8825 statements and attachments

NOTE  The This activity is a trade or business drop list is a required field 
and must be answered for each 8825 activity.
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Self-Employment Income

If Mark this box to include in self-employment income is selected at the top of the 
8825 screen, the amounts from the 8825 screen are included in the calculation for line 
14a of Schedule K and flow to each K-1. Self-employment calculations are shown on 
the “Wks Sch K” worksheet generated with the return.

Royalties Worksheet

When income and expenses from royalties are listed on screen 8825 (and Royalties is 
selected from the Type of property drop list), Drake Tax generates the Royalty Work-
sheet (“Wks PROY” in View/Print mode), along with a K-1 Royalty Worksheet 
(“Wks K-1 PROY”) for each partner. 

When a 1065 return is viewed, instead of the royalties income and expenses flowing to 
box 2, “Net rental real estate income,” of Schedule K-1, gross royalties flow to Sched-
ule K, line 7, “Royalties,” and expenses to Schedule K, line 13d, “Other deductions.” 
These amounts are also on the Royalty Worksheet. Form 8825 is not generated unless 
it is otherwise needed.

Form 8997, Initial and Annual Statement of QOF Investments 

An investor in a qualified opportunity fund (QOF) uses Form 8997 to inform the IRS 
of the QOF investments and deferred gains held at the beginning and end of the cur-
rent tax year, as well as any capital gains deferred and invested in a QOF in the current 
year, and QOF investments disposed of during the current tax year. When an investor 
acquires or sells the investment, it must also be reported on Form 8949, Sales and 
Other Dispositions of Capital Assets.

Find screen 8997 on the Other Forms tab of the Data Entry Menu.

Reporting 
QOF 

Investments

From the Part drop list on screen 8997, select which part you are completing:

• Part I: Used to declare the partnership’s QOF investments held at the beginning of 
the current tax year.

• Part II: Used to report the partnership’s capital gains for the current tax year that 
were deferred by investing in a QOF.

• Part III: Used to report the partnership’s QOF investments disposed of during the 
current tax year.

• Part IV: Used to report the partnership’s QOF investments held at the end of the 
current tax year due to current-year capital gain deferrals and prior tax years’ 
deferrals.

For each investment, enter the EIN of the QOF, along with the date the QOF invest-
ment was acquired, a description of the interest acquired, and the amount that was 
short-term deferred gain and long-term deferred gain.

Mark the check boxes at the bottom of the screen as appropriate.

Press PAGE DOWN to open a fresh screen and make another selection from the Part 
drop list.
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QOF Investments 

There are special rules for eligible gains invested in Qualified Opportunity Funds.

Form 8996 A partnership files Form 8996, Qualified Opportunity Fund, annually to report that the 
QOF meets the 90% investment standard of section 1400Z-2 or to figure the penalty if 
it fails to meet the investment standard

In Drake Tax, screen 8996 has been added for completing Form 8996. Screen 8996 is 
available from the Other Forms tab of the Data Entry Menu or through a link on 
line 15 of screen B.

Part I certifies that the partnership was organized to operate as a QOF. Part II deter-
mines whether the partnership meets the 90% investment standard for a QOF. Entries 
in Part IV calculate any penalties for each month that the QOF did not hold at least 
90% of its assets in QOZ property.

Complete Parts I, II, IV on screen 8996. Click the link at the bottom of the screen to 
complete Parts V and VI.

QOZ Tract 
Numbers

(New for 2019) On the Parts V and VI screen, select the form part to which data 
entered in this screen should flow. In the QOZ Tract No. column, enter the designated 
11-digit census tract number. (To find this tract number, go to irs.gov/pub/irs-drop/n-
18-48.pdf for a list of Designated Qualified Opportunity Zones, listed by state and 
county. 

See Form 8996 and its related instructions for more information.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake Tax carries 
the required adjustments to the appropriate line of the return and to Schedule M-1.

Manually reducing the expenses/deductions or increasing the income for these credits 
causes the return to be out of balance.

Extender Tax Credits Revived

Certain “extender” tax credits have been revived for 2019. In fact, these extenders are 
retroactive, so taxpayers who were unable to claim these credits in 2018 are now eligi-
ble for to file amended returns.

Adjustments are made to other income for the credit amounts for the following cred-
its: 

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

NOTE No adjustment is carried to Schedule M-3 automatically.
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• Form 8820, Orphan Drug Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8912, Credit to Holders of Tax Credit Bonds

• Form 8941, Credit for Small Employer Health Insurance Premiums

Employer Credit for Paid Family Medical Leave

Screen Code: 
8994

The Family Medical Act credit is available in all Drake Tax packages, using Form 
8994, Employer Credit for Paid Family and Medical Leave. Click the 8994 link on the 
Credits tab of the Data Entry Menu to open screen 8994.

Elections

The ability to make certain tax elections is included in the Partnership package. Elec-
tions are made and described on the ELEC screen (Figure 22 on page 70).

Making an Election in Drake Tax

Screen code: 
ELEC

To indicate that the partnership is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu).

2. Make a selection from the Election drop list.

3. Complete all other fields as applicable. Press F1 in any field to learn if that field is 
required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field (Figure 22 on page 70) 
shows that the field is required only for election options 08, 11, 13, 15, and 21, 
and it explains what, specifically, should be entered for each of these elections.
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Figure 22: Help text for Date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “Statement EL XX,” where “XX” is the number of 
the election. For example, election 01 (General Election Statement) is generated as 
“Statement EL 01.”

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date, amount, or location.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Safe Harbor Elections

A Building qualifies as Section 1.263... check box on screen 4562 applies a small 
taxpayer Safe Harbor election to a building listed in the Description field. An election 

NOTE
If the election option you selected is not listed in the help text for a 
field, then that field should be left blank. For example, if you chose 
election 01 (General Election Statement), you would not need to 
enter anything into the Date or year-ending field (help text in 
Figure 22).
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statement is produced and the building description as entered in the Description field 
are included in the election statement (see Figure 23).

This Sec. 1.263(a) - 3(n) Election can also be made from the ELEC screen, as can a 
Sec. 1.263(a) - 1(f) de minimis safe harbor election.

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

Election statements are generated with the return (Figure 23).

Figure 23: Election statements, including Safe Harbor election

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

Making Changes on the Fly
Screen code: 
PRNT

Use the PRNT screen (accessed from with the General or the Miscellaneous tabs of 
the Data Entry Menu) to override program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and 
select the desired options. Many “on the fly” changes override global setting from 
Setup > Options. 

1065 Items The following Form 1065 items can be “forced” (forced to be generated or printed) or 
suppressed from the PRNT screen:

• Force Schedules L, M-1, M-2 & K-1 Section L — Schedules L, M-1, M-2, and 
K-1 Section “L” are not printed unless required. To have these schedules printed 
with the return, select this box.

NOTE This Safe Harbor election covers buildings only.
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• Force Schedule K-1 Section L only — “Force” the program to generate the K-1 
section “L” information without generating any unnecessary Schedules L, M-2, 
and M-3. Any available data is generated in section “L, Partner’s capital account 
analysis,” of Schedule K-1.

• Print Form 4562 — Form 4562, Depreciation and Amortization, is not generated 
unless applicable. Select this box to force the Form 4562 to be printed. (To force 
Form 4562 for all returns, go to Setup > Options > Form & Schedule Options, 
and clear the check box labeled Print Form 4562 only when required.)

• Print next-year depreciation listing— Select this box to print the next year’s 
depreciation schedule if the option is not already selected in Setup > Options > 
Form & Schedule Options.

• Print inactive return — By default, the program does not generate a return for a 
partnership that is inactive. Select this option to override the default for an inac-
tive return.

• PIN — To have the preparer’s signature appear on the printed copy of return, 
enter the preparer’s PIN here This should be used for the client’s and preparer’s 
printed copies when the return has been e-filed.

• Items to Suppress — Select the boxes corresponding to any worksheets, forms, 
or functions you do not want printed with the return:

– “Wks Tax/Lic” or the “Wks Sal/Wage” reference on page 1

– Estimated Tax Payment Summary

– Printing of “Wks M-2,” Partners’ Capital Reconciliation Worksheet

– Proformas for next tax season

• Special Allocation Statement — Select to keep the statement listing all special 
allocations from being generated.

K-1 Items Described below are Schedule K-1 items that can be forced or suppressed from the 
PRNT screen:

• Select to print:

– The partner’s adjusted basis worksheet

– Page 2 of Schedule K-1 (codes)

• Select to Suppress:

– Schedule K-1, K-1 letter, K-1_ATT, or WK_PBAS

– Schedule K/K-1 Comparison Worksheet or the Capital Account Reconcilia-
tion

– K1_179 for each partner

– Marking of “Amended K-1” box on printed Schedule K-1

• Item L on Schedule K-1 (Partner’s capital account analysis) — Drake Tax 
now uses “Tax Basis” as the default reporting method as the partners’ capital 
accounts. If you are not using the “tax basis” method, make an entry in the Item L 
on Schedule K-1 section of the MISC screen (item #1 in Figure 24 on page 73). 
Mark either the GAAP or Sec 704(b) book check boxes, or type the method used 
in the Other text box. (If Other, Drake Tax includes a statement with the Sched-
ules K-1.)
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Figure 24: Items L and M of PRNT screen

• Item M on Schedule K-1 — Select a box (item #2 in Figure 24) to answer item 
M of Schedule K-1 for all partners. To answer it for each individual partner, go to 
the partners’ K1 screens. See “Item M Question” on page 53 for more informa-
tion.

See field helps (F1) for more information on the options available.

Overriding Other Setup Options

Select Turn off autobalance to disable the autobalance feature (see “Autobalance” on 
page 60) and select Prepare a Form 7004 extension if sending an extension applica-
tion. (See “Filing an Extension” on page 25.)

The following program default settings can also be overridden from the PRNT screen:

• Date to print on return

• Due date to print on letter and filing instructions (see note below)

• Amount on Form 1065, page 1, item F (“Total assets”)

• IRS Service Center

Much of the information contained in the worksheets is also available from the field-
level helps within the program. To access a field-level help, click inside a field and 
press F1, or right-click in a field and select Help > Help for this Field.

NOTE
The default due date for filing is printed on all letters and filing instruc-
tions generated with a return. You can override the default by enter-
ing an alternate due date in the Due date to print on letter and 
filing inst field.

NEW FOR 

2019

Filing instructions (federal and state) and envelope coversheets (part-
nership, IRS, state, city, and K-1s to partners) are no longer forced or 
suppressed from the PRNT screen—those options are now available 
from the COMM screen (formerly the LTR screen)—but there is a link to 
the COMM screen on the PRNT screen. Use the options on the COMM 
screen to override the global selections in Setup Options.

For more on global options and the COMM screen, see Chapter 2 of 
the 2019 Drake Tax User’s Manual.
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Optional (but Recommended) Security Information

The information on the Filing Security Information screen (SEC) of the Partnership 
package is transmitted when the tax return is e-filed. Completing this screen for fed-
eral returns is strictly optional for 2019; however, certain states will begin requiring 
this information in the near future.

Screen (SEC) is accessible through a link on screen 1 or from the Data Entry Menu.

Electronic Filing

Some partnerships with more than 100 partners are required to e-file Form 1065, 
Schedules K-1, and other related forms and schedules. For other partnerships, e-file is 
optional.

Steps for e-filing Form 1065 are the same as for e-filing Form 1040, with the excep-
tion of a bankruptcy return, which must be paper-filed. For detailed instructions on
e-filing returns in Drake Tax, see 2019 Drake Tax User’s Manual.

Additional Return Types

The following special types of business returns can be e-filed using Drake Tax:

• Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign 
Corporations

• FinCEN Form 114, Report of Foreign Bank and Financial Accounts

• Returns for entities using a 52-53–week year

• Short-year returns

• Inactive returns

For information on how to indicate a short-year return in Drake Tax, see “Short-Year 
Returns” on page 13.

Form 5471

Screens used to complete Form 5471, Information Return of U.S. Persons with 
Respect to Certain Foreign Corporations, are also found on the Foreign tab of the 
Data Entry Menu. This form is used by certain U.S. citizens and residents who are 
officers, directors, or shareholders, or partners in certain foreign corporations.

Taxpayers who must file this form are described in the IRS instructions. Form 5471 
will not be e-filed with the 1065 return. File by the due date (including extensions) for 
that return.

GILTI Income

Section 951A requires U.S. shareholders of controlled foreign corporations to deter-
mine and include their Global Intangible Low-Taxed Income (GILTI) in taxable 
income every year. Section 951A is effective for tax years of foreign corporations 
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beginning after 2017, and tax years of U.S. shareholders in which or with which such 
tax years of foreign corporations end.

In Drake Tax, use the I1 screen, available on the Foreign tab of the Data Entry 
Menu.

For details on using this form, see the IRS instructions for Form 5471 or review the 
field helps on screen I1.

Specified Foreign Corporations and Form 965

Section 965 of the Code (section 965) was amended by section 14103 of the Tax Cuts 
and Jobs Act (TCJA) requiring certain taxpayers to include in income an amount 
based on the accumulated post-1986 deferred foreign income of certain foreign corpo-
rations of which they are U.S. shareholders, either directly or indirectly through other 
entities. This is reported on Form 965, Inclusion of Deferred Foreign Income Upon 
Transition to Participation Exemption System.

In Drake Tax, the SFC screen and screens used to complete Form 965 are in the Form 
965 and Schedules section of the Foreign tab of the Data Entry Menu.

E-FILE FINCEN FORM 114

Use screens on the Foreign tab of the Data Entry Menu for entering data on foreign 
financial accounts, for filing FinCEN Form 114, Report of Foreign Bank and Finan-
cial Accounts, and Form 8804, Annual Return for Partnership Withholding Tax allo-
cable to foreign partners.

Screen 8813, used for completing Form 8813, Partnership Withholding Tax Payment 
Voucher, allows you to enter amounts paid by the partnership in the prior year on for-
eign tax withheld and to produce vouchers for making 2020 quarterly payments. The 
filing and mailing instructions are listed on screen 8813.

When you calculate a return in Drake Tax, any required information missing from 
screens 114 and FRGN generates EF Messages unique to the FinCEN Form 114 – 
listed in “FBAR Messages Pg” in View/Print mode. Before the FinCEN Form 114 can 
be eligible for e-file, all FinCEN 114 EF Messages on the “FBAR Messages Pg” must 
be cleared (and FinCEN has a green check mark on the Calculation Results window 
if you have the Pause option selected at Setup > Options > Calculation & View/
Print).

In data entry, open screen EF and mark the FinCEN 114 only check box. Click View 
(or press CTRL+V). “FinCEN114” will be indicated on the EF Status page in View/
Print mode and “Form 114” is displayed in the forms “tree” and is listed on the bill.

Close the return, and from the Home window toolbar, go to EF > Select Returns for 
EF. “FinCEN 114” will be displayed in the EF Documents column of the EF Return 

NOTE
As of publication of this manual, the IRS had not released its final ver-
sion of Form 965 and 951A; thus, the screens are inactive in Drake Tax. 
These screens will be activated with an update when the IRS releases 
its forms at the release date of this manual.
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Selector. EF. “FinCEN 114” will be displayed in the EF Documents column of the EF 
Return Selector.

Proceed as you would to e-file any other return in Drake Tax.

• Drake Tax produces “EF Notice - FBAR” as an acknowledgment that the e-filed 
FinCEN Form 114 report was received.

• No other returns—state or federal—can be transmitted with the FinCEN Form 114 
through Drake Tax.

• Form 114, Report of Foreign Bank and Financial Accounts (FBAR), can be e-
filed through Drake Tax in the same way all returns are e-filed through Drake Tax 
(see 2019 Drake Tax User’s Manual. This report can also be completed on, and 
submitted through, the BSA E-Filing System for the Financial Crimes Enforce-
ment Network website at http://bsaefiling.fincen.treas.gov/main.html

The link to the BSA website is still available on screen 114 for those who prefer that 
method of filing or who are seeking more information on the BSA E-Filing System for 
the Financial Crimes Enforcement Network.

Electing a 52-53–Week Year (Initial Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the Year screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning 
and Fiscal year ending dates. Use MMDDYYYY format, as shown in the exam-
ple in the figure below.

2. Mark the 52-53-week tax year box.

In this example, the fiscal year 
begins 09/28/2019 and ends 09/
25/2020 (the last Friday in Sep-
tember), giving the entity a 53-
week year for 2019.

3. Click the Year link to open the Election Options screen.

TIP For more on completing FinCEN Form 114, see “Foreign Financial 
Accounts” in Chapter 5 of the 2019 Drake Tax User’s Manual.

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.
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4. For line 1, 
select the 
month in 
which the 52-
53–week year 
ends for the 
current fiscal 
year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake Tax. To indicate that a return is inactive:

Screen Code: 
PRNT

1. Go to the PRNT screen, accessible from the General tab or the Miscellaneous 
tab of the Data Entry Menu.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, to the right of lines 1a and 1b). Zeros (“0”) 
are displayed where required by the IRS in order for amounts to be properly included 
in the e-file data.

Common Reject Codes

If one or more of the following IRS reject codes are generated when you e-file a 1065 
return, you must contact the IRS for further information.The e-file help desk number 
is (866) 255-0654.

• Reject Code R0000-922-01 — Filer’s EIN and name control in the return header 
must match data in the E-File Database, unless “Name Control” or “Name of 
address change” check box is checked, if applicable.

NOTE
Once a 52-53–week year is selected, the entity must use that 
accounting period every year. To change accounting periods, the 
entity must submit to the IRS Form 3115, Application for Change in 
Accounting Method. Screens for completing Form 3115 are available 
from the Other Forms tab of the Data Entry Menu.

NOTE All EF Messages must be cleared in order to e-file an inactive return.
Tax Year 2019 77



Binary Attachments Drake Tax Manual Supplement: 1065
• Reject Code R0000-900-01 — The return type indicated in the return header 
must match the return type established with the IRS for the EIN.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed, 
scanned into the computer, and attached to the return in order to be e-filed with the 
return.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake Tax:

1. Creating a PDF document to be attached

2. Informing the program that a PDF document will be sent with the return

3. Attaching the PDF document for e-file

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s Drake Documents file, your computer’s desk-
top, or anywhere you can readily find it.

Adding PDF 
Documents 

in Drake

To indicate in the program that a PDF document will be sent with the return:

1. Open the return in Drake Tax.

Screen Code: PDF 2. From the Data Entry Menu, click PDF Attachments, accessible from the Elec-
tronic Filing section of the General tab.

NOTE
If a reject associated with the return’s “Name Control” occurs, some of 
your questions can be answered on the IRS’s website. For details, go to 
irs.gov/Tax-Professionals/e-File-Providers-&-Partners/Using-the-Cor-
rect-Name-Control-in-e-filing-Partnership-Tax-Returns

TIP It’s a good idea to use the scanning feature in Drake Documents for 
this step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF documents if you have a PDF 
printer (such as Adobe Reader) installed.
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3. Fill out the columns on the PDF Attachments screen. See Table 3 for example.

4. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an 
EF Message regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window, there will be three PDF–related items in the View/Print window:

• An “MESSAGES” alert (item #1 in Figure 25)

• An “EF Attachments” document (blue squares in Figure 25) 

• An Attach PDF button on the toolbar (item #2 in Figure 25)

Figure 25: The MESSAGES file (1) and the Attach PDF button (2)

2. Click the “EF PDF” file from the forms tree to see a listing all documents entered 
on the PDF screen.

3. Click the “MESSAGES” file to view EF Messages, including information on how 
to attach the required documents to the return.

Table 3: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source
(This field is for your 
records only; it is not 
transmitted with the 
PDF.)

Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1065

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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4. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry. An X in a 
red circle means the document has not yet been attached; a check mark in a green 
circle indicates an attached document (Figure 26).

Figure 26: The EF PDF Attachments window

5. Click the row of a document to attach.

6. Click Browse.

7. Find to the proper folder, select the PDF file to attach, and click Open (or double-
click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return (and show a green check mark), recalculate the return. If all EF Mes-
sages have been resolved, the return is ready to be e-filed.

Importing Trial Balance Information

Drake Tax’s trial balance import feature allows data to be imported into a 1065 return 
from a trial balance worksheet. The trial balance template and importing function has 
the following benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

NOTE A flow chart of the trial balance importing process is available as 
Appendix A, Trial Balance Import (pages A-1 to A-2 of this manual).
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Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in 
Drake Tax 2008 or later. Like several other functions of the tax program, this feature 
requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake Tax 2019 
or update an existing client file from the prior year. Then, create a trial balance work-
sheet. (See “Opening a Template” on page 82.)

Take the following steps to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro settings are set to “Disable all macros with notification.” To do so, go to 
File > Options in Excel and select the Trust Center tab. Click Macro Settings 
and select Disable all macros with notification, then click OK.

• Disable Autobalance in Drake Tax — (optional) When autobalance is disabled, 
the program is prevented from automatically adjusting the year-end retained earn-
ings or capital amounts, thus allowing you to see any discrepancies in the balance 
sheet. To disable autobalance in Drake Tax, go to the PRNT screen and select 
Turn off autobalance (Figure 27).

Figure 27: Disable autobalance in Other Return Options section of PRNT screen

• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the partnership does not meet the filing requirement. If 
this is the case, you will have to override the default setting in order to have the 
amounts displayed on Schedule L. To force the Schedule L amounts to be printed, 
go to the PRNT screen and select the Force Schedules L, M-1, M-2, & K-1 Sec-
tion L box (Figure 28 on page 82).

NOTES

In Excel 2007, click the Office button in the upper left and then click the 
Excel Options button at the bottom of the window. (In Excel 2013, click 
the File tab then select Options from the menu on the left.) Next, select 
Trust Center from the list at left, then click the Trust Center Settings 
button. Select Macro Settings from the list on the left, then choose 
Disable all macros with notification. Click OK and then OK.
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Figure 28: Force Schedule L box for 1065 package

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail work-
sheets (CTRL+W) that are not required. For example, the IRS does not require a 
detail worksheet for the Gross receipts field on the INC screen; if a return has a 
detail worksheet for that field, the trial balance will not be imported correctly into 
the return. Detail worksheets are indicated by red shading, as shown in Figure 29.

Figure 29: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 84 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered 
into Drake Tax’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import from the Data Entry Menu toolbar. The 
preliminary Trial Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.
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4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

File Location Whenever a new template is opened, the tax program assigns it a default file location 
and name. Trial balance templates are saved in the “TB” folder of your Drake19 pro-
gram. 

To change the name of a file in Excel, select File > Save As and assign the new name.

Template 
Structure

The trial balance template consists of three title rows and six columns. The Partner-
ship Name and Year End Date title rows can be edited; double-click a row to change 
the title. Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount 
(Figure 30 on page 84).

NOTE
In older versions of Excel, you may see a Security Warning message 
with an Options button. Click Options to open the Security Options 
dialog box, then select Enable this content. Click OK. (In Excel 2013, 
click Enable Content.)

NOTE If saving a trial balance to a different location, make a note of where 
you store it. The program automatically looks in the default directory.

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake Tax to which the debit or 
credit amount is imported

Reported on Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 87.
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Figure 30: Schedule M-1 amount (item #1); totals (#2); and indication of balance (#3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0).

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons (Figure 31). If these cells do not work, you may need to activate 
them; see the Note in “Opening a Template” on page 82.

Figure 31: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 32 on page 85 
shows an example of the “Other Income” worksheet.

NOTE
Some data cannot be imported from the trial balance worksheet into 
the tax program and must be entered directly into the data entry fields 
within the Drake Tax program. For more on these categories of data, 
see “Special Conditions” on page 87.
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Figure 32: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the PTR TB tab (#1 in Figure 32) or click 
the Click to return to TB button above the worksheet tabs (#2 in Figure 32). Note 
that a detail tab (the “Other Income Detail” tab, #3 in Figure 32) might include one or 
more detail worksheets. 

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 30 on 
page 84).

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the program.

NOTE
Do not create detail worksheets in data entry of Drake Tax if the trial 
balance worksheet does not provide an equivalent detail worksheet or 
the trial balance will not be imported correctly.

NOTE The data cannot be imported into Drake Tax if the worksheet is out of 
balance.
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Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In older 
versions of Excel, click the Office button in the upper-left corner and select Save. In 
Excel 2013, click the File tab then Save.) To re-name a file when saving, select File > 
Save As. Trial balance templates are saved in the “TB” folder of your Drake19 pro-
gram.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake Tax, the trial bal-
ance information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. Use the Browse feature if nec-
essary. By default, each trial balance file is an Excel (.xls) file displaying the cli-
ent’s name and ending in “TB” for trial balance, as shown in the example in 
Figure 33. (See “File Location” on page 83.)

Figure 33: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import 
Options” on page 87.)

6. Click Next and wait for the import to be completed.

7. Click Finish.

NOTES

Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 87.

If you are already in the Trial Balance Import tool for the selected return, 
go to the Trial Balance Import window in Drake Tax and start at Step 3 
of the following procedure.
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The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

Additional 
Import 

Options

The program can import the following additional information when importing the trial 
balance data. Select the items to import or click Select All then click Next:

Special Conditions

Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake Tax data entry. Other items should be entered into the 
worksheet for balance purposes but do not flow to data entry; these must be entered 
separately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items are imported directly to the location indicated in the program 
and on the return. For example, the amounts shown in Figure 34 go to Schedule L, 
line 1, column d, in the program and are shown on page 5, line 1, column d of the 1065 
return.

Figure 34: Indication of where an amount will go in Drake Tax and on the return

The “Other Information” column in the trial balance worksheet indicates special con-
ditions and additional information regarding certain rows. Table 5 describes the most 
common notes in this column.

NOTE
If the program does not calculate the trial-balance information as 
expected, you can return to the trial balance worksheet, make adjust-
ments, and import the worksheet again

Buildings and other depreciable assets Accumulated depreciation

Goodwill and other intangible assets Land

8825/Rent information Accumulated amortization

COGS depreciation

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.
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All “does not import” notes are accompanied by further instructions in the “Reported 
on” column to the left of the “Other Information” column, as shown in Figure 35.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not import” on the trial balance. (Figure 35)

Figure 35: SCH2 screen required for “does not import” items

To complete an SCH2 detail screen in the tax program:

Screen code: 
SCH2

1. Open the SCH2 screen for the return.

2. Select the line number from Select line number from drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of Schedule L, press PAGE DOWN and repeat steps 
2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screens.

Depreciation Partnership (1065) returns can have up to four components of total depreciation:

• COGS 

• Real estate rental

• Rental other than real estate

• Any remaining depreciation

does not import Information cannot be imported and must be entered on the 
appropriate screen in Drake Tax. Screen is specified in the 
“Reported on” column to the left of “Other Information.”

optional Amount is optional; not required for import, but could require 
direct entry in the program.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.

Table 5: “Other Information” Column Notes

Note Description
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For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that rental expense detail worksheets are 
required for 8825 and RENT depreciation.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Schedule A on the return, and the rental depreciation 
expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, 
as applicable.

Because the remaining depreciation can 
comprise any number of assets, the 
amount entered on the trial balance does 
not flow to the return. To ensure that 
each component of the total remaining 
depreciation is calculated into the 
return, each asset must be entered on the 
applicable depreciation screens in data entry (figure above). Enter depreciable asset 
data on a 4562 detail screen, or enter the total depreciation on the override screens.

Rental 
Expenses

The following information applies only to partnerships with multiple rental properties.

The partnership trial balances include lines for rental income and expenses 
(Figure 36). Both rental expense items require a trial balance detail worksheet.

Figure 36: Rental expense rows on a trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 

NOTE
Enter 8825 and RENT depreciation amounts in the detail worksheets 
for importing purposes, but be aware that the 8825 and RENT screens 
in the program will have to be edited if 4562 detail screens (see figure 
below) are used.

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way 
to check that the amount on line 1 of Schedule M-1 is correct. Compare 
the calculated line 1 amount at the bottom of the trial balance to the 
equivalent line on Schedule M-1 of the calculated return. If the depreci-
ation amounts match but the line 1 amounts differ, an M-1 adjustment 
could be required.
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expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.

2. Enter the income totals on the trial balance sheet and the expense totals on the 
applicable detail sheets (Figure 36 on page 89).

3. Ensure that the balance sheet is in balance.

4. Import the trial balance worksheet into the return. The applicable screens in data 
entry now contain the figures entered on the trial balance worksheet.

5. Compare the M-1, line 1, amount on the trial balance to the M-1, line 1, amount 
on the calculated return to ensure that they match.

6. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

7. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).

Other Program Imports

Information for other outside worksheets can be imported into your 1065 return.

4562 Import With the 4562 Import function, you can import depreciable assets into Drake Tax 
from Excel worksheets (Excel 97-2003 and Excel 2007/2010 or later), from a TAB 
(tab delimited) file, or a .CSV (comma separated value) file. After the import is com-
pleted, each asset or transaction appears on a separate 4562 screen.

To successfully import depreciable assets from a worksheet into Drake Tax, the work-
sheet must be correctly formatted. The best and quickest way to get a properly format-
ted Excel worksheet is to download a template from Drake Software. To do so:

1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.

3. Click the Form 4562 Import information and sample spreadsheet link to open 
Drake Software Knowledge Base article 15982 on downloading the worksheet 
template. (Also in that article is a 4562 Import link to an instructional video.)

4. In the 15982 article, scroll down to “2018 - 1065 Import Template.” Click to 
download the template.

NOTE
If the amounts do not match, review the imported amounts to ensure 
that all data was imported. If the data appears to have been imported 
correctly, an M-1 adjustment could be necessary.

NOTE
To delete a screen in data entry, open the screen and press CTRL+D. If 
a multiple forms list appears, be sure that the screen to delete is 
selected, then click Delete.
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The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.

To use the 4562 Import feature:

1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.

3. When you are ready to begin the import process, click Next.

4. When the Form 4562 Import - Step 1 window is opened, click Browse, find your 
worksheet, click Open, then click Next.

5. When the Form 4562 Import - Step 2 window is opened, select the row where 
you wish to begin the import. (If the first row in the asset list is column headers, 
begin the import with row 2.) Click Next.

6. Click Import.

If you use an Excel worksheet from other sources, you can still import the asset infor-
mation into Drake Tax, but you need to aware of certain parameters. For the asset 
information to be imported correctly:

• In an Excel workbook, the import data must be on the first sheet in the workbook.

– View the workbook and check the tabs across the bottom of the window. If 
there is more than one tab, click and drag the worksheet you want to use to the 
left until it is the first tab.

– The name on the tab does not matter.

• The import file must contain the specified columns in the specified order. Each 
column represents a field on the 4562 screen as determined by the column loca-
tion (not by the header labels, which are optional)

• Except for column headers, do not put anything in the import file that should not 
be imported.

• If you include column headers, make sure to start importing on the first data row, 
not the header row (Start import at row 2).

• If totals are present, remove them. The totals may be imported, doubling your 
data.

The best way to enter dates in Excel is to format the date columns as text in the 
MMDDYYYY format (separators can be used or omitted).

Form 8949 
Import

With the Form 8949 Import/GruntWorx Trades feature, you can import capital gain 
and loss transaction data into Drake Tax from Excel worksheets (Excel 97-2003 and 
Excel 2007/2010 or later), from a TAB (tab delimited) file, or a .CSV (comma sepa-
rated value) file.

To successfully import transaction information from a worksheet into Drake Tax, the 
worksheet must be correctly formatted. (GruntWorx Trades are already properly for-

NOTE If a column in the template is red, that column will not be imported into 
the return. 
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matted.) The best and quickest way to get a properly formatted Excel worksheet is to 
download a template from Drake Software. To do so:

1. From the Home window toolbar in Drake Tax, click Support > Drake Software 
Knowledge Base.

2. When the Drake Software Knowledge Base is opened, in the Quick Search field 
in the top-right corner of the window, type 10139 and click the magnifying glass 
icon on the right.

3. After the search has been completed, click “10139: Schedule D Form 8949 Grunt-
worx Trades Import” from the Search Results.

4. In article 10139, scroll down to Attachments and click “2016 and Future…”

The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.

To use the 8949 Import feature:

1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 8949 Import.

3. In the Form 8949 Import window, review the example spreadsheet format.

4. When you are ready to begin the import process, click Next.

5. When the Form 8949 Import - Step 1 window is opened, click Browse, find your 
worksheet, click Open, then click Next.

6. When the Form 4562 Import - Step 2 window is opened, select the row where 
you wish to begin the import. (If the first row in the asset list is column headers, 
begin the import with row 2.) Click Next.

7. When the Form 4562 Import - Step 3 window is opened. Click Import.

After import, each transaction appears on a separate 8949 screen.

IMPORTANT

• For importing 8949 data into a 1065 return from the 
Drake Tax template, the “TSJ” column in the template 
represents the Property type field on screen 8949.

• If you are building your own worksheet for importing 
8949 data, include the “QSBS” (Qualified Small Busi-
ness Stock) columns in the worksheet but enter no 
amounts in those columns; when 8949 data is imported, 
those two columns are ignored.

• Do not include the EIN (QOF Only) field from screen 
8949 when building your worksheet.

NOTES
• Click the 8949 Import Tool link in KB article 10139 to view an 

instructional video using the 8949 Import feature.

• For more help, click Help from the Form 8949 Import window (in 
Step 3, above) or see “Form 4562 Import” and “Form 8949 Imports” 
in Chapter 5 of the 2019 Drake Tax User’s Manual.
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Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item. Drake Tax customers can complete and e-file Forms 3115 and 
related schedules and attachments for partnership returns.

Accessing Screens for Changing Accounting Method

Several screens may be required to 
complete Form 3115. These screens 
are accessible from the Change in 
Accounting Method box, located 
under the first Other Forms tab of the 
Data Entry Menu (figure at right). 
The screens accessible from the 
Change in Accounting Method sec-
tion include:

• Screen 3115 (Change in Account-
ing Method) — Used to access 
fields for Form 3115, including 
Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 14 & Pt III Ln 24b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

When you open screen 3115, the program displays the first of six screen tabs. As 
shown in Figure 37, you can access the various 3115 screens by clicking a tabbed link 
at the top of any of the 3115 screens.

Figure 37: Tab links on 3115 screen

NOTES
In some cases, Form 3115 must still be paper-filed.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for 
general automatic change procedures, and to Rev Proc. 2015-14 
for a list of automatic changes to which the automatic change pro-
cedures in Rev. Proc. 2015-13 apply.
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Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in 
Figure 37 on page 93) that allows you to link a screen or attachment to a particular 
Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake Tax. The first should be “1,” the second “2,” and so on. 
When using other screens, such as the 311E or ATT screens, you can use those num-
bers to indicate which instance of Form 3115 the 311E or ATT screen should be asso-
ciated with.

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF Messages (as applicable) when the return is calculated. All forms, schedules, EF 
Messages, and worksheets are accessible from View/Print mode.

EF Messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen to the list of EF Messages in View/Print mode.

EF “Notice” and EF “ACK” Pages

Similar to federal Form 9325, Acknowledgment and General Information for Taxpay-
ers who File Returns Electronically, generated with 1040 returns, the federal business 
packages generate an “EF Notice” page in View/Print mode for the main forms of fed-
eral returns, and state business packages generate a “(ST)EF ACK” page for the main 
forms of state returns.

These are Drake Tax-generated forms that serve the same purpose as Form 9325: an 
acknowledgment that a return has been transmitted through Drake Tax and received 
by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being 
processed) or an “R” ack (for a rejected return), the top section of the EF Notice is 
completed, noting the name and address of the client, the return type, the ERO who 
transmitted the return, and an indicator that the return was received by the IRS or 
applicable state agency.

NOTE If only one Form 3115 is being submitted, it is not necessary to enter 
anything in the Multi-form code box.

TIP
See Screen Help (accessible from the 3115 screen toolbar, from the 
right-click menu, or by pressing CTRL+ATL+?) to access the Form 3115 
instructions through the IRS website.

NOTE
All EF Messages must be eliminated before the return is eligible for 
e-file. EF Messages for Form 3115 attachments are eliminated when all 
required statements have been attached to the return.
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When you download and process your acknowledgments and receive an “A” ack, the 
second section of the EF Notice is generated, indicating the return was accepted by the 
IRS or state agency and the date the return was accepted. The submission ID number 
is also included.
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Drake Tax Manual Supplement: Partnerships
Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a partnership tax return from a 
trial balance worksheet.

Drake Tax’s specially designed trial balance template and importing function has the 
following benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See the next page for a flow chart describing the use of the trial balance import.
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Trial Balance Import: General Process

Process
complete!

Go to data entry an 
enter individual 

rentals on 8825 or 
RENT screens as 

applicable

Delete imported 
8825 and RENT 

screens

1120S & 1065:
Were rental totals entered 

in trial balance?

YES

NO

M‐1 
ent

1120 
return? NO
Trial Balance Template
(Import > Trial Balance Import)

‐ Direct entry data (cells with $0)
‐ Applicable detail worksheets
‐ Totals for:

‐ Depreciation
‐ Schedule L
‐ Rentals (1120S & 1065 only)

Compare M‐1, line 1: Does trial balance 
match Schedule M‐1, line 1?Prepare to use Trial 

Balance Import

‐ Activate  Excel macros
‐Disable autobalance
‐ Force Schedule L
‐Delete unnecessary detail worksheets

Did data
import 

correctly?

Make 
corrections in 
TB worksheet

NO

NO

Is an M‐1 
adjustment 
necessary?

Adjust 
amounts 

elsewhere in 
data entry

YES

Make 
adjustm

I
M
P
O
R
TData Entry

Enter any trial balance data that cannot be 
imported via Trial Balance Import

‐ Screen SCH2 for Schedule L items
‐ Screen 4562 for individual assets

        (depreciation)

YES

NOYES

990, 990‐EZ, or 
990‐PF return?

YES

NO
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Index 

Numerics
52-53-week year returns 76

A
accounting method

changing 77, 93
entering on 1065 14

accrual (accounting method) 14
address

entering on Form 1065 12
foreign 50
on K-1 letter heading 56
out-of-state 34

adjusted basis worksheet 52, 54, 72
adjustments

depreciation 61
to income and expenses 68

Aggregation
multiple 45

aggregation 41, 42
multiple 42

allocations
section 754 54
special (screen SA) 50, 54

amending
a 1065 return 14, 26
and TEFRA audit rules 27
K-1 letters 56

amortization 21, 23, 58
analysis

of capital accounts (Schedule M-2) 60
APPT screen, see Multi-State Apportionment
asterisks (on K-1 codes) 50
attachments

binary 78–80
to Form 3115 93

autobalance 60, 73

B
bad debts 17, 18
bankruptcy returns, e-filing not allowed for 74
basis 54

see also adjusted basis worksheet
book-to-tax differences (Schedule M-1) 60–62
business activity codes 14

Business Aggregation Number 42
PBAN 42

C
calendar year returns 13, 25
cash (accounting method) 14, 18
Centralized Partnership Audit Regime

electing out 30
Change in Accounting Method 93–94
Client Communications Editor (for letters) 55
codes

business activity 14
error/reject 77
K-1 49, 72
miscellaneous (screen 1) 34
multi-form 64, 94

compensation of partners 17
contact information (for state returns) 32
control number 48
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 55
coversheets 73
credits 16, 23, 68
Ctrl+W (detail) worksheets 15, 17, 82

D
data entry

for state information 32
importing trial balance into 80–90
state tabs in 32

dates
business start 14
tax year 13

DBA 12
deductions 17–23
depletion 22

oil and gas 45
depreciation

entering 20–21
for cost of goods sold (Schedule A) 15
of rentals 20, 64
on short-year returns 14
printing Form 4562 72
trial balance (business returns only) 88

detail (Ctrl+W) worksheets 15, 17, 82
Doing Business As 12
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domestic production activities deduction 55
due dates 25

E
EF_ACK page 94
e-filing 74

Form 8879-PE 26
Elections

Safe Harbor 70
electronic signatures (PIN) 25
employee benefit plans 22
envelope coversheets 73
error codes 77
expenses 17–23
exporting K-1 data 51
extensions 25, 73

F
farm profit or loss 16
filing instructions 73
final return 14
FinCEN Form 114 75
fiscal year returns 13
force print

end-of-year totals 58
foreign

addresses for partners 50
ownership 28
transactions 45

Form 114, Report of Foreign Bank and Financial Accounts
75

Form 3115 (Application for Change in Accounting Meth-
od) 77, 93–94

Form 4562 (Depreciation and Amortization) 64, 72
Form 4797 (Sales of Business Property) 16
Form 5471 (Information Return of U.S. Persons with Re-

spect to Certain Foreign Corporations) 74
Form 5884 (Work Opportunity Credit) 68
Form 6478 (Biofuel Producer Credit) 16, 68
Form 6765 (Credit for Increasing Research Activities) 23, 

68
Form 7004 (Application for Automatic Extension of Time 

to File) 25
Form 8082 (Notice of Inconsistent Treatment or Amended 

Return) 27
Form 8804, Annual Return for Partnership Withholding 

Tax allocable to foreign partners 75
Form 8820 (Orphan Drug Credit) 23, 69
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 64–67
Form 8825 (Rental Real Estate) 66
Form 8832, Entity Classification Election 31

Form 8844 (Empowerment Zone Employment Credit) 69
Form 8845 (Indian Employment Credit) 69
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 19, 69
Form 8864 (Biodiesel Fuels Credit) 16
Form 8873 (Extraterritorial Income Exclusion) 23
Form 8879-PE (IRS e-file Signature Authorization for 

Form 1065) 26
Form 8881 (Credit for Small Employer Pension Plan Start-

up Costs) 69
Form 8912 (Credit to Holders of Tax Bonds) 68
Form 8912 (Credit to Holders of Tax Credit Bonds) 69
Form 8916A (Supplemental Attachment to Schedule M-3)

63
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 69
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 23
Form 8990, Limitation on Business Interest Expense Under 

Section 163(j) 30
Form 8994, Employer Credit for Paid Family and Medical 

Leave 69
Form 8996, Qualified Opportunity Fund 68
Form 8996, Qualified Opportunity Funds 31
Form 8997, Initial and Annual Statement of QOF Invest-

ments 67
Form 8997, Initial and Annual Statement of Qualified Op-

portunity Fund (QOF) Investments 31
Form 965 (Inclusion of Deferred Foreign Income Upon 

Transition to Participation Exemption System) 75
Form 965, Inclusion of Deferred Foreign Income Upon 

Transition to Participation Exemption System 75
Form T (Forest Activities Schedules) 22

G
gains and losses 16
GILTI 74, 76
Global Intangible Low-Taxed Income 74
grid data entry 49
gross receipts 15
guaranteed payments 17

H
header information 12
health insurance 22
health savings account (HSA) 18

I
import

4562 90
8949 91
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importing trial balance 80–90
inactive returns 77
income 14–17
instructions for filing 73
insurance

and contributions to benefit plans 22
proceeds, income from 17

interest
expense 19
income 17
ownership of (Schedule B) 27–32
self-charged 19

inventory (on Schedule A, Cost of Goods Sold) 15
IRAs 22
Item M (on Schedule K-1) 53

K
K-1 codes 49
K-1 cover letter 55–56
K-1 export 51
K-1, Schedule for 1065 46–53

L
letters (K-1) 55

M
M, item (on Schedule K-1) 53
maintenance costs 18
medical care for employees 22
MISC screen 10
Multi-State Apportionment 32

N
name control reject 78
net

farm profit or loss 16
gain or loss 16

next-year depreciation listing 72
number of partners 14

O
oil and gas depletion 45
ordinary gains and losses 16
other

costs (Schedule A) 15
deductions 23
income (loss) 16

overrides
of calculations for partners 50
on screen 1 34

ownership
changes 51
of interest (Schedule B) 27

P
partners

compensation of 17
foreign addresses for 50
guaranteed payments to 17
health insurance 18
returns with numerous 50
rounding 47
Schedule K-1 46
special allocations for 54
updating data annually 54

payments, guaranteed 17
PBAN 42
PBAN fields. 41
PDF attachments 78
PIN (electronic) signatures 25
principal business activity 14
principal product or service 14
printing

1065 returns 71
adjusted basis worksheets 72
cover letter for K-1 55, 56
force 71
K-1 items 50
suppressing/forcing documents 71

prior-year returns, updating 12

Q
QBI

aggregations 43
Qualified Business Income

aggregation 41
Qualified Business Income (QBI) 37
Qualified Opportunity Fund (QOF) 31
Qualified Opportunity Funds 68

R
real estate 88
receipts 15
refunds, state 17
reject codes 77
rent paid on business property 18
rental activities 64–67
Rental properties

safe harbor 40
repair costs 18
resident state 32, 34
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retirement plans 22
returns

52-53-week year 76
bankruptcy 74
extensions for 25
fiscal and calendar year 13
inactive 77
short-year 13
signing 25
updating prior-year 12

rounding partner 47
royalties worksheet 67

S
SA screen 35
Safe Harbor 40
Safe Harbor Elections 70
scanning attachments for e-filing 78
Schedule A (Cost of Goods Sold) 15–16
Schedule B (Other Information) 27
Schedule B-1 (Information on Partners Owning 50%) 28
Schedule K (Partners’ Distributive Share Items) 34–46
Schedule K-1

grid data entry 49
Partner Information 46–53
Supplemental information 52

Schedule K-1 (Share of Income, Deductions, Credits, etc.)
sorting business K-1s 48

Schedule L (Balance Sheet per Books) 56–60, 71, 72
Schedule M-1

adjustments 59
Reconciliation of Books 60
Reconciliation of Books With Return 71, 72

Schedule M-2 (Analysis of Capital Accounts) 60
Schedule M-3

force printing 63
Schedule M-3 (Net Income (Loss) Reconciliation) 60, 62
section

179 21, 54
481 17
754 21, 54

Section 199A items 39
security

business packages 74
security screen 74
self-employment income 67
SEP or SIMPLE plans 22
short-year returns 13
signatures, electronic 25
signs return partner 25, 47, 55
special allocations 35
special allocations (screen SA) 50, 54
Specified Foreign Corporations 75

Specified service trades or businesses 39
state

overriding information related to 34
resident 32
tabs in data entry 32
tax refunds 17

statements 59
elections 70
Schedule L 58
Schedule M-3 63

state-specific information 32

T
tax

years (fiscal vs calendar) 13
Tax and Payments 23
Tax Equity and Fiscal Responsibility Act (TEFRA) 27
TAX screen 23
taxes and licenses 18
trial balance import

and depreciation 16
and SCH2 screens 59
instructions for using 80–90

U
updating

a prior-year return 12
partner data annually 54

W
wages 17
What’s New for 2018 9

Y
Year screen 13
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